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Chapter 1: Virtual Gateway’s Provider Data 
Management (PDM) System 

OVERVIEW 

The Virtual Gateway is an Internet portal designed by the Executive Office of Health and Human Services 

(EOHHS) to provide the general public, medical providers, community-based organizations, and EOHHS 

staff with online access to health and human services. By consolidating information and online services 

in a single location on the Internet, the Virtual Gateway simplifies the process of connecting people to 

critical health and human services programs and information. 

Provider Data Management is a web-based service that gives Purchase of Service (POS) providers and 

EOHHS agencies a single place to view and edit information commonly requested by Health and Human 

Services agencies.  The Provider Data Management System is a web based EOHHS application that 

supports:  

1. State agencies within the Executive Office of Health and Human Services through a centralized 

location to view provider information required for contracting monitoring. 

2. Provider organizations with whom EOHHS agencies contract by hosting a central repository of all 

Purchase of Service (POS) contracts, service data, forms and reports, and organizational profiles. 

3. Annual Provider Qualification review process aimed at minimizing financial and administrative risk 

to the Commonwealth and the people served through the Purchase of Service system. 

4. Creation of specialized reports and service directories designed to meet federal funding 

requirements and assist general public in identifying service providers. 

5. Special initiatives undertaken by the EHS to meet legislative directives. 

The PDM Business Service is intended to serve as a well-organized, easily navigated ‘filing system’ of 

provider data. It is important to note that the application requires both web-based data entry and 

population of the PDM data from external source systems. 

PDM is an application built to manage providers servicing the Purchase of Service (POS) provider 

population. This enhanced functionality will support enrolling provider agencies and individual providers 

to provide different waiver program services. 

Provider Management allows individual providers and provider agencies access to update their 

demographic information; and manage their services and qualifications in the system. Certain business 

rules apply in order to modify service related information especially when they are part of an existing 

plan and are currently providing services to consumers. Provider initiated service modifications and 

additions go through a review and approval process by the reviewers. 

The Provider Data Management system has four primary pages.   
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 Information: The Information page stores information about a Provider such as Corporate 

Contact Information, Provider’s PDM Contact, Executive Contact, and general corporate 

information (Mission Statement and Corporate Description).   

o Service Directory: Service Directory (SD) is a tool developed by the Massachusetts 

Department of Developmental Services (DDS) to assist individuals, families, support 

brokers, and clinical staff to locate services and service providers in the Commonwealth 

of Massachusetts. The SD helps clients to locate particular service providers, search for 

services and supports provided in their community and provide information about 

specific services funded by the Department of Developmental Services (DDS) under the 

Home and Community - Based Services Waivers. 

o Service Directory will appear as a link on the Information page to Providers who have 

contracts/services with the Department of Developmental Services (DDS).  

o Visit the Service Directory page to find services and supports for clients and/or their 

family member. (https://service.hhs.state.ma.us/pdm4public/ssdHome.jsp) 

 Qualification: The Qualification page stores information about the POS Provider’s qualifications 

such as Principle Purchasing Agency (PPA), Qualification Status, UFR Filing Period reviewed, Date 

UFR Received by OSD, Date Qualification Status Last Updated, Concerns/Issues, and Comments.  

The Qualification Page has two links: 

o Financial Ratios: The Financial Ratios page assists agencies in assessing the financial 

stability of a provider.  The EOHHS Purchase of Service (POS) Integrity Unit established 

the standard Financial Assessment Measures and benchmarks. The Financial Ratios page 

is pre-populated when the Operational Services Division (OSD) receives a provider’s 

annual Uniform Financial Report (UFR) and parses the information into the OSD 

database.   

o Corrective Measures: The Corrective Measures page displays, by PQ Fiscal Year, the UFR 

Audit Findings, the Corrective Action Plan, and Audit Records (OSA Audit).   

 Contract Detail: The Contract Detail page stores information about the POS Provider’s contracts 

for the current fiscal year such as Activity Code, Activity Name, Doc ID, Object Code, Maximum 

Contract Obligation, Expended to Date, and Unexpended Amount.  For Release 5.0 PDM will 

only display contracts with Object Codes MM3 and M03. 

Note: The information found under the Contract Details tab is sourced from the 

Commonwealth’s Information Warehouse.  Information about services offered, but not 

contracted through EOHHS is entered by the provider. 

 Surplus Revenue: The Surplus Revenue page is primarily used by the Principal Purchasing 

Agency (PPA) to record and retain an account of the surplus revenue liability based on the 

Annual SSR of 5% limit.  

Security roles determine what a user can view and edit in PDM.  Refer to Appendix B: PDM Security 

Matrix for a listing of security roles.  

More information about PDM can be found via the EOHHS Virtual Gateway: www.mass.gov/vg/pdm.  

https://service.hhs.state.ma.us/pdm4public/ssdHome.jsp
http://www.mass.gov/vg/pdm
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SYSTEM REQUIREMENTS 

All computers used to access the Virtual Gateway require Internet Explorer 6.0 or higher. For the PDM 

application, the minimum system requirements are the following. 

• Windows (2000 or XP Professional) 

• Internet Explorer 7.0 or 8.0 

• 1280x960 screen resolution 

• 300MHz CPU and 128MB RAM 

Additionally, the preferred system features to enhance the performance of PDM are the following. 

• Windows XP Professional 

• 1440x900 screen resolution 

• 500MHz CPU and 256MB RAM 

Acceptable Alternatives: 

• Browsers: Firefox 

• Compatible with Dragon and JAWS 

Note: Java Script is required and must be enabled to use the PDM application. To enable JAVA Script, 
follow the steps below. 

Enable JAVA scripting on IE 7.0, IE 8.0 

• From the Tools menu, or the Tools drop-down in the upper right, choose Internet options. 

• Click the Security tab, and then click Custom Level. 

• Scroll to the “Scripting” section of the list. For “Active Scripting,” click Enable. 

• Click OK, and confirm if prompted. 

• Close and restart your browser.  

Enable JAVA scripting on Firefox 

• From the Tools menu, select Options. 

• Click Content. 

• Check or uncheck Enable Java Script and Enable Java. 

Note:  If a lower screen resolution is selected, then the user needs to select the “Smaller” text size. 

 Select the View menu from the Internet Explorer browser. 

 Select Text Size>>Smaller. 
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Chapter 2: Getting Started 

ACCESSING PDM ON THE VIRTUAL GATEWAY (VG) 

Select the link: Virtual Gateway Login Assistance Page for more information on accessing the Virtual 

Gateway. 

1. To use the Virtual Gateway's PDM system, users must log on to the Virtual Gateway at 

https://gateway.hhs.state.ma.us/authn/login.do. 

 

Figure 1: Welcome to the Virtual Gateway page. 

From the Welcome to the Virtual Gateway page: 

2. Enter your VG Username and Password.  

From the VG Business Service page:  

3. Select the Provider Data Management link.  

http://www.mass.gov/eohhs/provider/training-and-edu/vg/login-help-for-providers-and-state-agency-staff.html
https://gateway.hhs.state.ma.us/authn/login.do
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  Figure 2: Virtual Gateway Business Service page. 

Notes:  

 If logging on for the first time, refer to your New User Email for Username and temporary password.  

 Refer to the Virtual Gateway Login Assistance (http://www.mass.gov/eohhs/provider/training-and-

edu/vg/login-help-for-providers-and-state-agency-staff.html) page for additional guidance on 

logging on to the Virtual Gateway and account maintenance.   

PDM Welcome Page 

The Welcome to the Provider Data Management Information System page appears.  

 

Figure 3: Welcome to the Provider Data Management Information System page. 
  

http://www.mass.gov/eohhs/provider/training-and-edu/vg/login-help-for-providers-and-state-agency-staff.html
http://www.mass.gov/eohhs/provider/training-and-edu/vg/login-help-for-providers-and-state-agency-staff.html
http://www.mass.gov/eohhs/provider/training-and-edu/vg/login-help-for-providers-and-state-agency-staff.html
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The options available from the PDM Home Page are briefly described in the table below: 

Menu Option Description 

Manage Provider This option will redirect the user to the applicable page based on the 

assigned security role of the user and allow user to view qualified provider 

information about the current services that are being provided.   

Help This option will redirect the user to the PDM User Guide documentation.  

This documentation is available in Word and PDF format. 

Logoff Exits PDM and redirects the user to the Virtual Gateway Home Page. 

Virtual Gateway Customer Service 

The Virtual Gateway Customer Service provides login and technical assistance to providers and state 

Agency staff. 

If you have questions on accessing PDM on the Virtual Gateway, contact Virtual Gateway Customer 

Service for assistance.  

 800-421-0938 (Voice) 

 617-847-6578 (TTY for people who are deaf, hard of hearing, or speech disabled) 

 Monday through Friday (8:30 a.m. to 5:00 p.m.) 

Questions about the PDM Program 

If you have any questions regarding PDM or this application please contact the PDM project office via 

EHS-DL-PDMITTeam@MassMail.State.MA.US.  

mailto:EHS-DL-PDMITTeam@MassMail.State.MA.US
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Chapter 3: Principal Purchasing Agency 
(PPA) and Agency Observer Roles 

OVERVIEW 

Principal Purchasing Agency (PPA): The Principal Purchasing Agency (PPA) role allows agency staff to 

edit and view provider information. This role can also enter information that supports the POS provider 

evaluation and annual prequalification process; and access predefined agency reports. 

Agency Observer: This role allows designated agency staff to view only Provider information and access 

predefined reports. 

PDM Role Information Qualifications 

(Including Financial Ratio 

and Corrective Measures) 

Contract 

Detail 

Surplus Revenue 

Principal 

Purchasing 

Agency (PPA)  

View View/Edit View View/Edit 

 

Agency Observer View View View View 

Reminders When Using PDM: 

 All fields denoted with an asterisk (*) are required fields and must be completed in order to save 

the record. 

 Do not save a record until all sections are completed. If the user tries to save before completing 

all required fields within each section, the user will receive error messages at the top of the page 

listing the missing data. 

 If you attempt to navigate to another page while in Edit mode without first saving you will 

receive a warning message (different text depending on the web browser you are working in) 

such as: 

o Firefox: “This page is asking you to confirm that you want to leave – data you have 

entered may not be saved.” 

o Internet Explorer: “Are you sure you want to navigate away from this page?  This page 

is asking you to confirm that you want to leave – data you have entered may not be 

saved.  Press OK to continue, or Cancel to stay on the current page.” 

For guidance on using JAWS with PDM, refer to Appendix B: JAWS Commands.   
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PROVIDER SEARCH 

The Principal Purchasing Agency (PPA) and Agency Observer both have the ability to search for 

providers.  It is important to know how to search for providers within the database.  The search page 

allows the user to search for an existing Provider in order to manage or view (dependent on role) an 

existing provider who is active for the current PQ year and who has had a contract with the 

Commonwealth in the past five years. 

Using a name, FEIN or an alphabetical listing the search engine conducts a search of the database to 

display a provider’s profile.  

The Search page is accessed by selecting Manage Provider from the Navigation menu.  

 

Figure 4: Welcome to the Provider Data Management System page. 

The Provider Search page allows users to search for entries in two ways: 

 Search By Provider 

 Search Alphabetically 

 
Figure 5: Provider Search page. 

Search By Provider 

1. Select the Search By Provider radio button. 

2. Select the Search button. 
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Figure 6: Searching by Provider option. 

Note: The Provider Search page allows users to search for records in three ways.  Users can search by 

using one option or a combination of options. 

 FEIN (Federal Employment Identification Number) 

 Name (Provider Name) 

 PPA (Principal Purchasing Agency) 

1. Type the Name. (Full or Partial name). 

There are three buttons under the Provider Search section: 

 Search: To conduct a search per entered criteria. 

 Clear: To clear criteria from fields. 

 Return: To return to the Search option page. 

2. Select the Search button 

The Provider Search page returns with results based off of entered criteria.  

 

Figure 7: Provider Search page returns with results based off of entered criteria. 

Note: Wildcard Search, the * (asterisk) can be used as a wildcard in the name field to search for a 

provider. If you are unsure of the full name of the provider,  or want to see all the options using a 

portion of a name , use the wild card to search. (i.e. *key will produce Catherine Key, Berkshire* will 

produce Berkshire Community Center etc., *education* will produce any provider who has the word 

education in their organization name.) 
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3. Select record to view. The user will be redirected to the PDM Information page. 

Search Alphabetically 

1. Select Search Alphabetically radio button. 

2. Select the Search button. 

 
Figure 8: Provider Search - Search Alphabetically. 

3. Select the Select drop down menu to select the corresponding letter for the Provider Name. 

4. Select the Search button. 

 

Figure 9: Provider Search - Search Alphabetically by Provider Name. 

The Provider Search page returns with results based off of entered criteria.  

 
Figure 10: Search Alphabetically - The Provider Search page returns with results based off of entered criteria. 

5. Select record to view. The user will be redirected to the PDM Information page. 
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PDM Information Page 

The PDM Information page contains demographic information about the selected provider and displays 

the following information: 

 Corporate Contact Information  

 Provider’s PDM Contact 

 Executive Contacts 

 General Corporate Information 

Users assigned the Principal Purchasing Agency (PPA) and Agency Observer roles have View only rights 

on the Information page.   

The Information page has the following button located at the bottom of the page: 

 Return to Search: Returns user to the Provider Search page. 

 
Figure 11: PDM Information page. 
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PDM Qualification Page 

The PDM Qualification page is populated when the EOHHS Principal Purchasing Agency (PPA) Provider 

Qualification Officer (PQO) completes the review process.   The PDM system calculates these fields using 

data from Provider’s UFR filing from OSD data feed and cannot be edited.  

A user assigned the Principal Purchasing Agency (PPA) role can edit specific data fields on this page. 

A user assigned the Agency Observer role has View only rights. 

 
Figure 12: PDM Qualification page. 
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Qualification – Viewing PQ Year 

PDM maintains the current PQ year along with previous years.  The Qualifications page defaults to the 
current PQ Year.  To view a prior year,  

1. Select the PQ Year drop down arrow and select the Year to be viewed.  
2. Select the Update button. 

 

Figure 13: Under the Qualifications page, changing the PQ Year to 2011 and selecting the Update button. 

Note: Each time the PQ Year is selected it must be followed by selecting the update button to ensure 
all data is up to date per the selection. 

A user with the Principal Purchasing Agency (PPA) role can edit the following sections on the 
Qualifications page: 

• Qualification Status 

• Concerns / Issues 

• Comments 

1. Select the Edit button at the bottom of the page. 

 

Figure 14: Selecting the Edit button on the Qualification page. 
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Parent/Child/Affiliate Providers 

The Parent/Child/Affiliate Providers section allows the Principal Purchasing Agency (PPA) and Agency 
Observer to view the other providers associated to this provider.  

Note: Parent/Child/Affiliate Providers information will only be visible if the Provider has Child or 
Affiliate Providers. 

 
Figure 15: Parent/Child/Affiliate Providers section under the Qualification page. 

1. Select record to view. The user will be redirected to the PDM Information page for that 
provider organization. 

Status 

The Status section allows the PPA to update the Qualification Status.   

To update the Qualification Status field, 

1. Select the Qualification Status drop down arrow and select one of the following options: 

 Conditional 

 Limited 

 No POS Business 

 Pending 

 Provisional 

 Public Entity 

 Qualification with CAP 

 Rejected 

 Unconditional 
2. Select the Save button. 

 
Figure 16: Status section under the Qualification page. 

  



Page 21 of 78  PDM USER GUIDE RELEASE 5.0 v2 

Concerns/Issues  

A user with the Principal Purchasing Agency (PPA) role can edit the Concerns/Issues section.  If a 

checkmark is placed in any one of the checkboxes, the user will need to add an explanation one the 

Corrective Measures page.  Refer to the Corrective Measures in this chapter for more information. 

 
Figure 17: Concerns/Issues section on the Qualification page. 

Comments 

A user with the Principal Purchasing Agency (PPA) role can add /delete comments in this section. 

To Add a Comment: 

1. Type the Comments you desire in the Comment field. 

2. Select the Save button. 

The comment will display in the comments dialog box. 

To Delete a Comment: 

1. Select the Delete link. 

2. Select the Save button. 

Note:  Only the author can edit and/or delete his or her own comments. 

The graphic below represents comments added along with highlighting the Delete option. 

 
Figure 18: Comments section on the Qualification page. 

Note:  A reminder that if you navigate away from any page while in Edit mode without saving, PDM will 
prompt a Warning screen. 
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PDM Qualification – Financial Ratios 

The Financial Ratios page contains vital financial ratios for current and past two years. 

1. Select the Financial Ratios link 

 
Figure 19: Highlighting the Financial Ratios page from the Qualification page. 

The Financial Ratios page displays the last 3 fiscal years prior to the PQ year selected. 

1. Select any one of the links in the first column to open the Financial Ratios Definitions page. 

 

Figure 20: Financial Ratios page which is under Qualification. 

2. Select Back to open the Financial Ratios page or select Return to search to open the Provider 
Search page. 
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PDM Qualification – Corrective Measures 

The Corrective Measures page is part of Provider Profile and contains corrective measures. 

Under the UFR Audit Findings section, if the Status field has a ‘YES’ this indicates that a checkmark was 
entered selected under the Qualification page for the Internal Control, Compliance, Financial Ratios, 
Management Letter, Notes to Financials, or Other.  While an optional field, it is recommended that the 
PPA enter an explanation under UFR Audit Findings when the status is ‘YES’.  

1. Select Edit at the bottom of the page. 

 
Figure 21: Corrective Measures page highlighting the Concerns/Issues section which requires explanation when "Yes" is 

displayed. 

2. Type an explanation for each Concerns/Issues with a ‘Yes’ in the Status field. 
3. Select the Save button. 

 
Figure 22: Completed Concerns/Issues section under Corrective Measures page. 



 

PDM USER GUIDE RELEASE 5.0 v2  Page 24 of 78 

 

The Corrective Action Plan is updated by data on the UFR and by OSD/CIW.  This is a View only section. 

 
Figure 23: Corrective Action Plan section under the Corrective Measures page. 

The Audit Records (OSA AUDIT) section can be updated by the PPA. 

1. Type the Audit Number. 
2. Type the Issue Date. (Format: DD/MM/YYYY or  
3. Select the CAP Status. (Options: Open or Close) 
4. Type the Audit Resolution Summary. 
5. Select Financial Audit Findings.  (Options: Yes or No) 
6. Select the Add Audit Record. 

 
Figure 24: Audit Records (OSA Audit) section under the Corrective Measures page. 
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PDM CONTRACT DETAILS 

The Contract Detail page stores information about the POS Provider’s contracts for the current fiscal 

year such as Activity Code, Activity Name, Doc ID, Object Code, Maximum Contract Obligation, 

Expended to Date, and Unexpended Amount.  For Release 5.0 PDM will only display contracts with 

Object Codes MM3 and M03. 

The Principal Purchasing Agency (PPA) and Agency Observer roles allow designated staff from within the 

organization to view this page.  These roles do not have Edit rights on this page. 

Note: The information found under Contract Details is sourced from the Commonwealth’s Information 

Warehouse.  Information about services offered, but not contracted through EOHHS is entered by the 

provider. 

This page provides the Purchasing Agency (PPA) and Agency Observer with a snapshot of all of current 

year contracts, by EOHHS agency. 

 
Figure 25: Contract Detail page lists all contracts a provider has with EOHHS agencies. 
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PDM SURPLUS REVENUE 

The Surplus Revenue page is primarily used by the Principal Purchasing Agency (PPA) to record and 

retain an account of the surplus revenue liability based on the Annual SSR of 5% limit. If an excess 5% 

Surplus Revenue Liability exists, the Principal Purchasing Agency utilizes the corresponding fields below 

to provide an accounting of the negotiation with the Provider to satisfy the liability owed the 

Commonwealth.  

 
Figure 26: PDM Surplus Revenue page. 

The Principal Purchasing Agency (PPA) can edit the following fields on the Surplus Revenue page: 

 Date of Agency/Provider Agreement 

 Cash Reimbursement 

 Free Care 

 Adjusted Unit Rate Contract 

 Other (*notes in comments) 

 Costs Offset Refiled UFR 

 Estimated Date Reimbursement will be completed 

 Date Reimbursement completed 

 Comments 

After entering in the information, the PPA selects the Save button. 
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Figure 27: PDM Surplus Revenue page in Edit mode. 
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Chapter 4: POS Program Operations Role 

OVERVIEW 

This role allows POS Operations staff to Add and Manage Providers in the system. This role also has 
access to edit capability and the ability to assign PPAs.  In addition this role has access to the reports 
menu. 

POS Program Operations This role allows POS Program Operations access the provider PDM records. 

POS Program Operations with this access have the capability to edit and update information. 

PDM Role Information Qualifications 

(Including Financial Ratio 

and Corrective Measures) 

Contract 

Detail 

Surplus Revenue 

POS Program 

Operations  

View/Edit View/Edit View View/Edit 

 

Reminders When Using PDM: 

 All fields denoted with an asterisk (*) are required fields and must be completed in order to save 

the record. 

 Do not save a record until all sections are completed. If the user tries to save before completing 

all required fields within each section, the user will receive error messages at the top of the page 

listing the missing data. 

 If you attempt to navigate to another page while in Edit mode without first saving you will 

receive a warning message (different text depending on the web browser you are working in) 

such as: 

o Firefox: “This page is asking you to confirm that you want to leave – data you have 

entered may not be saved.” 

o Internet Explorer: “Are you sure you want to navigate away from this page?  This page 

is asking you to confirm that you want to leave – data you have entered may not be 

saved.  Press OK to continue, or Cancel to stay on the current page.” 

For guidance on using JAWS with PDM, refer to Appendix B: JAWS Commands. 
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PROVIDER SEARCH 

A user with the POS Program Operations role has the ability to search for providers.  It is important to 

know how to search for providers within the database.  The search page allows the user to search for an 

existing Provider in order to manage or view (dependent on role) an existing provider who is active for 

the current PQ year and who has had a contract with the Commonwealth in the past five years. 

Using a name, a portion of a name or an alphabetical listing the search engine conducts a search 
of the database to display a provider’s profile.  

The Search page is accessed by selecting Manage Provider from the Navigation menu.  

 

Figure 28: Welcome to the Provider Data Management Information System page. 

The Provider Search page allows users to search for entries in two ways: 

 Search By Provider 

 Search Alphabetically 

 
Figure 29: Provider Search page 

Search By Provider 

1. Select the Search By Provider radio button. 

2. Select the Search button. 
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Figure 30: Searching by Provider option. 

Note: The Provider Search page allows users to search for records in three ways.  Users can search by 

using one option or a combination of options. 

 FEIN # (Federal Employment Identification Number) 

 Name (Provider Name) 

 PPA (Principal Purchase Agency) 

3. Type the Name. (Full or Partial name). 

There are three buttons under the Provider Search section: 

 Search: To conduct a search per entered criteria. 

 Clear: To clear criteria from fields. 

 Return: To return to the Search option page. 
 

4. Select the Search button. 

The search results page open.  

 
Figure 31: Provider Search page returns with results based off of entered criteria 

5. Select record to view. The user will be redirected to the PDM Information page. 

Note: Wildcard Search, the * (asterisk) can be used as a wildcard in the name field to search for a 

provider. If you are unsure of the full name of the provider,  or want to see all the options using a 

portion of a name , use the wild card to search. (i.e. *key will produce Catherine Key, Berkshire* will 

produce Berkshire Community Center etc., *education* will produce any provider who has the word 

education in their organization name.) 
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Search Alphabetically 

1. Select Search Alphabetically radio button. 

2. Select the Search button. 

 
Figure 32: Provider Search - Search Alphabetically 

3. Select the Select drop down menu to select the corresponding letter for the Provider Name. 

4. Select the Search button. 

 

Figure 33: Provider Search - Search Alphabetically by Provider Name. 

The Provider Search page returns with results based off of entered criteria.  

 
Figure 34: Search Alphabetically - The Provider Search page returns with results based off of entered criteria. 

 

5. Select record to view. The user will be redirected to the PDM Information page. 
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PDM INFORMATION 

The Information page stores demographic information about a Provider such as Corporate Contact 

Information, Provider’s PDM Contact, Executive Contact, and General Corporate Information (Mission 

Statement and Corporate Description).   

After a user with the POS Program Operation role searches for and selects a provider record they are 

redirected to the PDM Information page. 

Users assigned the POS Program Operations role have View and Edit rights on the Information page.   

The Information page has two buttons located at the bottom of the page: 

 Edit: The Edit button will appear for users with the PDM Contracted Providers Operations role. 

 Return to Search: Returns user to the Provider Search page. 

 
Figure 35: PDM Information page. 
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Corporate Contact Information  

Under Corporate Contact Information the following fields can be edited by a user with the POS Program  

Operation role: 

 Alternate Address 

 Phone, Fax 

 Email, Website 

Note: The Provider Name, FEIN and Legal Address fields are not editable. This data comes from the 

Commonwealth’s Information Warehouse (CIW). 

 
Figure 36: Fields that can be updated on Information > Corporate Contact Information section of the Information page. 

If only updates to the Corporate Contact Information section are needed, select the Save button at the 
bottom of the page. 

Provider’s PDM Contact 

Under Provider’s PDM Contact the following fields can be edited by a user with the POS Program 
Operation role: 

 First, Middle, and Last  

 Phone, Email, Fax 

 

Figure 37: Fields that can be updated on Information > Provider's PDM Contact section of the Information page. 

If only updates to the Provider’s PDM Contact section are needed, select the Save button at the bottom 
of page. 
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Executive Contacts 

Under Executive Contacts > CEO/Executive Director the following fields can be edited by a user with the 
POS Program Operation role: 

 First, Middle, and Last  

 Phone, Email 

Under Executive Contacts > Chief Financial Officer the following fields can be edited by a user with the 
POS Program Operation role: 

 First, Middle, and Last  

 Phone, Email 

 

Figure 38: Fields that can be updated on Information > Executive Contacts section of the Information page. 

If only updates to the Executive Contacts section are needed, select the Save button at the bottom of 
page. 

General Corporate Information/ Mission Statement 

Under General Corporate Information the following field can be edited by a user with the POS Program 
Operation role: 

 Mission Statement 

 Corporate Description 

 

Figure 39: Fields that can be updated on Information > General Corporate Information section on the Information page. 

If only updates to the General Corporate Information section are needed, select the Save button at the 
bottom of page. 
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PDM Qualification 

The PDM Qualification page is populated when the EOHHS Principal Purchasing Agency (PPA) Provider 

Qualification Officer (PQO) completes the review process.   The PDM system calculates the financial 

ratios field using data from Provider’s UFR filing from OSD data feed and cannot be edited.  

 
Figure 40: PDM Qualification page. 

Qualification – Viewing PQ Year 

PDM maintains the current PQ year along with previous years.  The Qualifications page defaults to the 
current PQ Year.   

To view a prior PQ Year,  

1. Select the PQ Year drop down arrow and select the Year to be viewed.  
2. Select the Update button. 
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Figure 41: Under the Qualifications page, changing the PQ Year to 2011 and selecting the Update button. 

Note: Each time the PQ Year is selected it must be followed by selecting the update button to ensure 
all data is up to date per the selection. 

The Qualification page now displays the data corresponding to PQ Year 2011.   

A user assigned the POS Program Operation role can update the following fields: 

• PPA, MEP Status, Qualification Status  

• Concerns / Issues, Comments 

3. Select the Edit button at the bottom of the page. 

 

Figure 42: Selecting the Edit button on the Qualification page. 
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Qualification 

Under the Qualification section, a user with the POS Program Operation role can edit and update the 

following fields: 

 PPA (Principal Purchasing Agent) 

 MEP Status (Multiply Entity Provider) 

 Qualification Status 

 Concerns/Issues/Comments 

Note: The PPA field displays the agency associated to the contract in PDM.  Contracts feed over from the 

CIW with DMR, DSS and WEL associated with the contract, but those department names have changed.  

For prequalification purposes DMR contracts need to be associated with DDS contract, DSS contracts 

with DCF; and WEL contracts with DTA. 

1. Select the PPA drop down arrow and select correct agency code. 

2. Select the Save button. 

 

Figure 43: Selecting the PPA on the Qualification page. 

The MEP Status field can be updated. 

3. Select the MEP Status drop down arrow and select the MEP Status. 

MEP Status field has the following options: 

 Contracting Child/Affiliate 

 Contracting Parent 

 Non Contracting Child/Affiliate 

 Non Contracting Parent 

 Single Entity 

4. Select the Save button. 

 

Figure 44: Selecting the MEP Status on the Qualification page. 
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Parent/Child/Affiliate Providers 

The Parent/Child/Affiliate Providers section allows the POS Program Operation staff person to view 
and update, if needed, the other providers associated to this provider. 

Note: Parent/Child/Affiliate Providers information will only be visible if the Provider has Child or 
Affiliate Providers. 

 

Figure 45: Parent/Child/Affiliate Providers section under the Qualification page. 

5. Select record to view. The user will be redirected to the PDM Information page for that provider 
organization. 

Status 

The Status section allows the POS Program Operation staff person to update the Qualification Status.   

6. Select the Qualification Status drop down arrow and select one of the following options: 

 Conditional 

 Limited 

 No POS Business 

 Pending 

 Provisional 

 Public Entity 

 Qualification with CAP 

 Rejected 

 Unconditional 
7. Select the Save button. 

 
Figure 46: Status section under the Qualification page. 

  



Page 39 of 78  PDM USER GUIDE RELEASE 5.0 v2 

Concerns/Issues  

A user with the Principal Purchasing Agency (PPA) role can edit the Concerns/Issues section.  If a 

checkmark is placed in any one of the checkboxes, the user will need to add an explanation one the 

Corrective Measures page.  Refer to the Corrective Measures in this chapter for more information. 

 
Figure 47: Concerns/Issues section under the Qualification page. 

Comments 

A user with the Principal Purchasing Agency (PPA) role can add /delete comments in this section. 

To Add a Comment: 

1. Type the Comments you desire in the Comment field. 

2. Select the Save button. 

The comment will display in the comments dialog box. 

To Delete a Comment: 

3. Select the Delete link. 

4. Select the Save button. 

Note:  Only the author can edit and/or delete his or her own comments. 

The graphic below represents comments added along with highlighting the Delete option. 

 
Figure 48: Comments section under the Qualification page. 

 

Note:  A reminder that if you navigate away from any page while in Edit mode without saving, PDM will 
prompt a Warning screen. 
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PDM Qualification – Financial Ratios 

The Financial Ratios tab contains vital financial ratios for current and previous two fiscal years. 

1. Select the Financial Ratios link. 

 
Figure 49: Highlighting the Financial Ratios page from the Qualification page. 

2. Select any of the links in the first column to open the definitions page. 

 
Figure 50: Financial Ratios page which is under Qualification. 

3. Select Back to return to the main Qualification page or select Return to search to open the 
search page.  
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PDM Qualification – Corrective Measures 

The Corrective Measures page is part of Provider Profile and contains Corrective measures along with 
comments.  

Under the UFR Audit Findings section, if the Status field has a ‘YES’ this indicates that a checkmark was 
entered selected under the Qualification page for the Financial Ratios, Management Letter, Notes to 
Financials, or Other.  While an optional field, it is recommended that the PPA enter an explanation 
under UFR Audit Findings when the status is ‘YES’.  Select Edit at the bottom of the page 

 

Figure 51: Corrective Measures page highlighting the Concerns/Issues which requires explanation when "Yes" is displayed. 

1. Type an explanation for each Concerns/Issues with a ‘Yes’ in the Status field. 
2. Select the Save button. 

 

Figure 52: Completed Concerns/Issues section under Corrective Measures page. 
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The Corrective Action Plan is updated by data on the UFR and by OSD/CIW.  This is a View only section. 

 

Figure 53: Corrective Action Plan section under the Corrective Measures page. 

The Audit Records (OSA AUDIT) section can be updated by the PPA. 

1. Type the Audit Number. 
2. Type the Issue Date. (Format: DD/MM/YYYY or  
3. Select the CAP Status. (Options: Open or Close) 
4. Type the Audit Resolution Summary. 
5. Select Financial Audit Findings.  (Options: Yes or No) 
6. Select the Add Audit Record. 

 

Figure 54: Audit Records (OSA Audit) section under the Corrective Measures page. 
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PDM CONTRACT DETAILS 

The Contract Detail page stores information about the POS Provider’s contracts for the current fiscal 

year such as Activity Code, Activity Name, Doc ID, Object Code, Maximum Contract Obligation, 

Expended to Date, and Unexpended Amount. For Release 5.0 PDM will only display contracts with 

Object Codes MM3 and M03.  The POS Program Operation role allows designated staff from within the 

organization to view this page.  This role does not have Edit rights on this page. 

Note: The information found under Contract Details is sourced from the Commonwealth’s Information 

Warehouse.  Information about services offered, but not contracted through EOHHS is entered by the 

provider. 

This page provides the POS Program Operations staff with a snapshot of all of current year contracts, by 

EOHHS agency. 

 
Figure 55: Contract Detail page lists all contracts a provider has with EOHHS agencies. 
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PDM SURPLUS REVENUE 

The Surplus Revenue page is primarily used by the Principal Purchasing Agency (PPA) to record and 

retain an account of the surplus revenue liability based on the Annual SSR of 5% limit. If an excess 5% 

Surplus Revenue Liability exists, the Principal Purchasing Agency utilizes the corresponding fields below 

to provide an accounting of the negotiation with the Provider to satisfy the liability owed the 

Commonwealth.  

 

Figure 56: PDM Surplus Revenue page. 

A user assigned the POS Program Operation role can edit the following fields on the Surplus Revenue 

page: 

 Date of Agency/Provider Agreement 

 Cash Reimbursement 

 Free Care 

 Adjusted Unit Rate Contract 

 Other (*notes in comments) 

 Costs Offset Refiled UFR 

 Estimated Date Reimbursement will be completed 

 Date Reimbursement completed 

 Comments 
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After entering in the information, the PPA selects the Save button. 

 

Figure 57: PDM Surplus Revenue page in Edit mode. 
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Chapter 5: DDS Program Operations and 
DDS Operations Observer Roles 

OVERVIEW 

The DDS Program Operations and DDS Operations Observer have access to and maintain the Service 

Directory in PDM.  The Service Directory is a tool for consumers, their families, and circle of support to 

search for services and service providers in the Commonwealth of Massachusetts.  The data in the 

Service Directory is maintained in PDM by users assigned the DDS Program Operations role and they 

have the ability to add, modify and delete data in the Service Directory pending approval from 

appropriate source within DDS. Clients looking for provider services in their area can be referred to the 

Service Directory website at https://service.hhs.state.ma.us/pdm4public/ssdHome.jsp. 

DDS Program Operations: This role allows designated DDS Program staff access to the Providers 

associated to DDS waivers and services. These users will have access to add and manage providers, as 

well as waiver services. In addition they will have the capability to manage the Providers Service 

Directory Profile. Finally, they will have access to reports menu. 

DDS Operations Observer: This role allows designated DDS staff to view only Provider information and 

predefined reports. 

PDM Security Role Service Directory 

DDS Program Operations Add/Edit/Delete/View 

DDS Operations Observer View 

Reminders When Using PDM: 

 All fields denoted with an asterisk (*) are required fields and must be completed in order to save 

the record. 

 Do not save a record until all sections are completed. If the user tries to save before completing 

all required fields within each section, the user will receive error messages at the top of the page 

listing the missing data. 

 If you attempt to navigate to another page while in Edit mode without saving, you will receive a 

warning message (different text depending on the web browser you are working in) such as: 

o Firefox: “This page is asking you to confirm that you want to leave – data you have 

entered may not be saved.” 

o Internet Explorer: “Are you sure you want to navigate away from this page?  This page 

is asking you to confirm that you want to leave – data you have entered may not be 

saved.  Press OK to continue, or Cancel to stay on the current page.” 

For guidance on using JAWS with PDM, refer to Appendix B: JAWS Commands. 
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PROVIDER SEARCH 

The DDS Program Operations and DDS Operations Observer both have the ability to search for providers.  

In order to view provider records in PDM a search is required.  The Search page is accessed by selecting 

Manage Provider from the Navigation menu.  

 

Figure 58: Welcome to the Provider Data Management Information System page. 

The Provider Search page allows users to search for entries in three ways: 

1. FEIN (Federal Employee Identification Number) 

2. Name (Provider Name) 

3. Waiver Program (Specific DDS program) 

 

Figure 59: Provider Search page. 

Search by FEIN: 

1. Type in FEIN. (9-digits in length) 

2. Select the Search button. 



Page 49 of 78  PDM USER GUIDE RELEASE 5.0 v2 

 

Figure 60: Provider Search page returns with results based off of entered criteria - FEIN. 

Search by Name: 

1. Type in Name (Full or Partial name). 

Note: Wildcard Search, the * (asterisk) can be used as a wildcard in the name field to search for a 

provider. If you are unsure of the full name of the provider,  or want to see all the options using a 

portion of a name , use the wild card to search. (i.e. *key will produce Catherine Key, Berkshire* will 

produce Berkshire Community Center etc., *education* will produce any provider who has the word 

education in their organization name.) 

2. Select the Search button. 

 

Figure 61: Provider Search page returns with results based off of entered criteria - Name. 
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Search by Waiver: 

1. Select the Waiver Program drop down menu. 

Available Programs: 

 ALL (Default) 

 Adults Services 

 Autism Spectrum Services 

2. Select the Search button. 

 

Figure 62: Provider Search page returns with results based off of entered criteria - Waiver Program. 

SERVICE DIRECTORY 

Once the Provider Search is executed and requested results are displayed, the user selects the Provider 
record by clicking in the row which redirects the user to the Service Directory page. 

The Service Directory page lists the following information: 

 Provider’s Details 

 Other Contact Information 

 Service Information 

Users assigned the DDS Program Operations role have Read rights access along with add/modify in the 
Service Directory.  The DDS Observer has Read rights only. 

Based on assigned role, the Service Directory page will display the following buttons at the bottom of 
the page:  

 DDS Program Operations: Edit and Return to Search 

 DDS Observer: Return to Search 
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Figure 63: Service Directory page with Edit button highlighted. 
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UPDATE SERVICE DIRECTORY 

A user with the DDS Program Operations role has the access rights to add/modify/delete information on 

the Service Directory page. 

Provider's Details 

Note: The Name and FEIN fields are not editable. The data comes from the Commonwealth’s 

Information Warehouse (CIW). 

Under Provider’s Detail the following fields can be edited by a user with the DDS Program Operations 

role: 

 Address Line 1 *, Address Line 2 

 City *, State *, Zip * 

 Phone and Ext * 

 Website, Email  

If only updates to the Provider’s Detail section are needed,  

 Select the Edit button. 

 Update information as needed. 

 Select the Save button. 

Other Contact Information 

Under Other Contact Information the following fields can be edited by a user with the DDS Program 

Operations role: 

 First *, Last * 

 Phone and Ext * 

 Email  

If only updates to the Other Contact Information section are needed,  

 Select the Edit button. 

 Update information as needed. 

 Select the Save button. 
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Figure 64: Service Directory page with Provider's Details and Other Contact Information displayed. 

Service Information 

The Service Information section (when in Edit mode) allows a user to add/modify/delete service 
information. 

Searching for an Existing Service 

The Select Service section in the Service Directory displays 10 records at a time on the page.  If more 

than 10 records exist the user should use the link First Previous 1 2 Next Last to navigate and locate the 

record. 

There are two buttons under the Service Information section: 

 Add/Modify Service: To save or modify a record in Service Directory. 

 Delete Service: To delete a record in Service Directory. 

 
Figure 65: Service Directory page displayed with highlight around First Previous Next Last navigation links and the 

Add/Modify Service and Delete buttons. 
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ADD SERVICE 

When a new service needs to be added a user with the DDS Program Operations role can add the service 
to the Service Directory. 

1. Search and select Provider from the Provider Search page. 

2. Select the Edit button from the Service Directory page. 

3. Select the Program Type * from the drop down menu. 

4. Select the Service Type * from the drop down menu. 

5. Type in the Start Date * (Format: MM/DD/YYYY or select the Calendar icon to select the date) 

6. Select the City * (To select multiple cities use Shift + click). 

7. Select the Language * (To select multiple languages use Shift + click). 

8. Select the Add/Modify Service button. 

 
Figure 66: Service Directory page displayed with highlight around Add/Modify Service button. 

PDM will return the validation message “Service added successfully.” 

MODIFY SERVICE 

If a service needs to be modified due to a change in the Start Date or when an additional City or 
Language needs to be added a user with the DDS Program Operations role can modify an existing service 
on the Service Directory. 

1. Search and select Provider from the Provider Search page. 

2. Select the Edit button. 

3. Locate and select service to be modified from the Select Service section. 

Note: The Program Type and Service Type fields are not editable when modifying a service. 

4. Update the Start Date * field, if needed (Format: MM/DD/YYYY or select the Calendar icon to 

select the date) 

5. Update the City * field, if needed (To select multiple cities use Shift + click). 

6. Update the Language * field, if needed (To select multiple languages use Shift + click). 
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7. Select the Add/Modify Service button. 

 
Figure 67: Service Directory page displayed with highlights around Add/Modify Service fields. 

PDM will return the validation message “Service modified successfully.” 

DELETE SERVICE 

If a service needs to be deleted a user with the DDS Program Operations role has the access to delete a 
service from the Service Directory. 

1. Search and select the provider from Provide Search page. 

2. Under Service Information, locate and select the service to be deleted from the Select Service 

listing. 

3. Select the Delete Service button.  
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Figure 68: Service Directory page displayed with highlights around the Delete Service fields. 

PDM will return the validation message: “Service deleted successfully.”  

Note: All fields denoted with an asterisk (*) are required fields and must be completed in order to save 

the record. 

  



Page 57 of 78  PDM USER GUIDE RELEASE 5.0 v2 

Chapter 6: PDM Contracted Providers 
Operations and Observer Provider Roles 

OVERVIEW 

The PDM Contracted Providers Operations and PDM Observer Provider roles allow designated staff from 

within their organization to view and edit information in PDM. 

PDM Contracted Providers Operations: This role allows providers access to their PDM record only. 

Providers with this access have the capability to edit and update company profile information. Access 

will include the ability to upload and replace required documents. This role will also have access to 

provider specific reports. (May have access to Salary Reserve functionality - to follow in later release). 

PDM Observer Provider: This role allows providers access to VIEW only the provider's PDM company 

profile information. This role will have access to designated reports specific to the provider's company 

business with EOHHS. 

PDM Role Information Qualifications 

(Including Financial Ratio 

and Corrective Measures) 

Contract 

Detail 

Surplus Revenue 

PDM Contracted 

Providers 

Operations 

View/Edit View View View 

PDM Observer 

Provider 

View View View View 

Reminders When Using PDM: 

 All fields denoted with an asterisk (*) are required fields and must be completed in order to save the 

record. 

 Do not save a record until all sections are completed. If the user tries to save before completing all 

required fields within each section, the user will receive error messages at the top of the page listing 

the missing data. 

 If you attempt to navigate to another page while in Edit mode without first saving you will receive a 

warning message (different text depending on the web browser you are working in) such as: 

 Firefox: “This page is asking you to confirm that you want to leave – data you have entered may 

not be saved.” 

 Internet Explorer: “Are you sure you want to navigate away from this page?  This page is asking 

you to confirm that you want to leave – data you have entered may not be saved.  Press OK to 

continue, or Cancel to stay on the current page.” 

For guidance on using JAWS with PDM, refer to Appendix B: JAWS Commands. 
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PDM INFORMATION 

The Information tab stores information about a Provider such as Corporate Contact Information, 
Provider’s PDM Contact, Executive Contact, and General Corporate Information (Mission Statement and 
Corporate Description).   

When a provider selects the ‘Manage Provider’ from the Welcome page they are automatically 
redirected to the Provider page (no search is required) and defaults to the Information page. 

Users assigned the PDM Contracted Providers Operations role have Edit and Read rights on the 

Information page.  The PDM Observer Provider has View rights only. 

The Information page has the following button located at the bottom of the page: 

 Edit: The Edit button will appear for users with the PDM Contracted Providers Operations role. 

 No button will display for users with the PDM Observer Provider role. 

 
Figure 69: PDM Information page with Edit button highlighted. 
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Corporate Contact Information  

Under Corporate Contact Information the following fields can be edited by a user with the PDM 

Contracted Providers Operations role: 

 Alternate Address 

 Phone, Fax 

 Email, Website 

Note: The Provider Name, FEIN and Legal Address fields are not editable. This data comes from the 

Commonwealth’s Information Warehouse (CIW). 

 
Figure 70: Fields that can be updated on Information > Corporate Contact Information section of the Information page. 

If only updates to the Corporate Contact Information section are needed, select the Save button at the 
bottom of the page. 

Provider’s PDM Contact 

Under Provider’s PDM Contact the following fields can be edited by a user with the PDM Contracted 
Providers Operations role: 

 First, Middle, and Last  

 Phone, Email, Fax 

 

Figure 71: Fields that can be updated on Information > Provider's PDM Contact section of the Information page. 

If only updates to the Provider’s PDM Contact section are needed, select the Save button at the bottom 
of page. 
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Executive Contacts 

Under Executive Contacts > CEO/Executive Director the following fields can be edited by a user with the 
PDM Contracted Providers Operations role: 

 First, Middle, and Last  

 Phone, Email 

Under Executive Contacts > Chief Financial Officer the following fields can be edited by a user with the 
PDM Contracted Providers Operations role: 

 First, Middle, and Last  

 Phone, Email 

If only updates to the Executive Contacts section are needed, select the Save button at the bottom of 
page. 

 

Figure 72: Fields that can be updated on Information > Executive Contacts section of the Information page. 

General Corporate Information 

Under General Corporate Information the following field can be edited by a user with the PDM 
Contracted Providers Operations role: 

 Mission Statement 

 Corporate Description 

If only updates to the General Corporate Information section are needed, select the Save button at the 
bottom of page. 

 

Figure 73: Fields that can be updated on Information > General Corporate Information section on the Information page. 
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SERVICE DIRECTORY 

Note: Only provider organizations that have contracts with DDS will see the Service Directory link under 
the Information page.   

Once the Provider Search is executed and requested results are displayed, the user selects the Provider 
record by clicking in the row to display the Corporate Information page. To the right of the information 
page is the Service Directory link. 

1. Select the Service Directory link. 

 

Figure 74: Service Directory link on the Information page. 

The Service Directory page lists the following information: 

 Provider’s Details 

 Other Contact Information 

 Service Information 

The Provider Organization with DDS contracts has Read rights only to this information. 

 
Figure 75: Service Directory page (view only). 
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Searching for an Existing Service 

The Select Service section in the Service Directory displays 10 records at a time on the page.  If more 

than 10 records exist the user should use the link First Previous 1 2 Next Last to navigate and locate the 

record. 

 

Figure 76: Service Directory page displayed with highlight around First Previous Next Last navigation links. 
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PDM QUALIFICATION 

The PDM Qualification page is populated when the EOHHS Principal Purchasing Agency (PPA) Provider 

Qualification Officer (PQO) completes the review process.   The PDM system calculates the financial 

ratios field using data from Provider’s UFR filing from OSD data feed and cannot be edited.  

Users assigned the PDM Contracted Providers Operations role and PDM Observer Provider have View 

rights only to the Qualification page and associated links. 

 

Figure 77: PDM Qualification page. 

Qualification – Viewing PQ Year 

PDM maintains the current PQ year along with previous years.  The Qualifications page defaults to the 
current PQ Year.   

To view a prior PQ Year,  

1. Select the PQ Year drop down arrow and select the Year to be viewed. (This example will select 
2011). 

2. Select the Update button. 
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Figure 78: Under the Qualifications page, changing the PQ Year to 2011 and selecting the Update button. 

Note: Each time the PQ Year is selected it must be followed by selecting the update button to ensure 
all data is up to date per the selection. 

Parent/Child/Affiliate Providers 

The Parent/Child/Affiliate Providers section allows the user to view the other provider organizations 
associated to this provider. 

Note: Parent/Child/Affiliate Providers information will only be visible if the Provider has Child or 
Affiliate Providers. 

 

Figure 79: Parent/Child/Affiliate Providers section under the Qualification page. 

3. Select record to view. The user will be redirected to the PDM Information page for that provider 
organization. 
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PDM Qualification - Financial Ratios 

The Financial Ratios page assists agencies in assessing the financial stability of a provider.  The EOHHS 

Purchase of Service (POS) Integrity Unit established the standard Financial Assessment Measures and 

benchmarks. The Financial Ratios page is pre-populated when the Operational Services Division (OSD) 

receives a provider’s annual Uniform Financial Report (UFR) and parses the information into the OSD 

database.   

The PDM Contracted Providers Operations and PDM Observer Provider roles allow designated staff from 

within the organization to view this page.  This page is View only for all associated roles. 

1. Select the Financial Ratios link 

 

Figure 80: Highlighting the Financial Ratios link on the Qualification page. 

The Financial Ratio page displays the last 3 fiscal years prior to the PQ year selected. 

2. Select any one of the links in the first column to open the Financial Ratios Definitions page. 
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Figure 81: Financial Ratios page which is located under the Qualification page. 

3. Select Back to return to the Financial Ratio page. 
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PDM Qualification - Corrective Measures 

The Corrective Measures page displays, by PQ Fiscal Year, the UFR Audit Findings, the Corrective Action 

Plan, and Audit Records (OSA Audit).   

The PDM Contracted Providers Operations and PDM Observer Provider roles allow designated staff from 

within the organization to view this page.  This page is View only for all associated roles. 

 
Figure 82: Corrective Measures page. 

Qualification – Viewing PQ Year 

PDM maintains the current PQ year along with previous years.  The Qualifications page defaults to the 
current PQ Year.   

To view a prior PQ Year,  

1. Select the PQ Year drop down arrow and select the Year to be viewed.  
2. Select the Update button. 
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Figure 83: Corrective Measures page with the PQ Year highlighted. 

Note: Each time the PQ Year is selected it must be followed by selecting the update button to ensure 
all data is up to date per the selection. 
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PDM CONTRACT DETAILS 

The Contract Detail page stores information about the POS Provider’s contracts for the current fiscal 

year such as Activity Code, Activity Name, Doc ID, Object Code, Maximum Contract Obligation, 

Expended to Date, and Unexpended Amount.  For Release 5.0 PDM will only display contracts with 

Object Codes MM3 and M03. 

The PDM Contracted Providers Operations and PDM Observer Provider roles allow designated staff from 

within the organization to view this page.  These roles do not have Edit rights on this page. 

Note: The information found under Contract Details is sourced from the Commonwealth’s Information 

Warehouse.  Information about services offered, but not contracted through EOHHS is entered by the 

provider. 

This page provides the Provider with a snapshot of all of current year contracts, by EOHHS agency.  
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Figure 84: Contract Detail page lists all contracts a provider has with EOHHS agencies. 

PDM SURPLUS REVENUE 

The Surplus Revenue page is primarily used by the Principal Purchasing Agency (PPA) to record and 

retain an account of the surplus revenue liability based on the Annual SSR of 5% limit. If an excess 5% 

Surplus Revenue Liability exists, the Principal Purchasing Agency utilizes the corresponding fields below 

to provide an accounting of the negotiation with the Provider to satisfy the liability owed the 

Commonwealth.  

 
Figure 85: PDM Surplus Revenue page. 
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Appendix A: PDM Security Matrix 

  

Provider Data Management (PDM) 

PDM Roles Information Qualifications 
Financial 

Ratios 

Correction 

Measures 

Contract 

Detail 

Surplus 

Revenue 

Service 

Directory 

Principle 

Purchasing 

Agency 

View 
Edit 

Update 
View 

Edit 

Update 
View 

Edit 

Update 
NA 

State 

Agency 

Observer 

View View View View View View NA 

POS 

Program 

Operations 

Edit 

Update 

Edit 

Update 
View 

Edit 

Update 
View 

Edit 

Update 
NA 

DDS 

Program 

Operations 
NA NA Na NA NA NA 

Add 

Edit 

Update 

DDS 

Operations 

Observer 

NA NA NA NA NA NA View 

PDM 

Contracted 

Providers 

Operations 

Edit 

Update 
View View View View View View 

PDM  

Provider 

Observer  

View View View View View View View 
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Appendix B: JAWS COMMANDS 

READING TEXT 

Command Description 

 Say Prior Character 

 Say Next Character 

Num Pad 5  Say Character 

Num Pad 5  twice quickly Say Character Phonetically 

Insert  +  Say Prior Word 

Insert  +  Say Next Word 

Insert  + Num Pad 5  Say Word 

Insert  + Num Pad 5  twice quickly Spell Word 

 Say Prior Line 

 Say Next Line 

Insert  +  Say Current Line 

Insert  + twice quickly Spell Current Line 

Alt  +  Say Prior Sentence 

Alt  +  Say Next Sentence 

Alt +Num Pad 5  Say Current Sentence 

Insert  + Home  Say to Cursor 

Insert  + Page Up  Say from Cursor 

Insert  + Home  twice quickly Spell to Cursor 

Insert  + Page Up  twice quickly Spell from Cursor 

Insert  +  Say All 

 Fast Forward during a Say All 

 Rewind during a Say All 

Insert  + 5  Say Color 

Num Pad 5  three times quickly Say ASCII or Hexadecimal Value 

Insert  + F , twice quickly Say Font 

Ctrl  + Insert  +  Start Skim Reading 

Ctrl  + Insert  + Shift  +  Skim Reading dialog box 

Insert  + Windows Key  +  Display Skim Reading Summary 

Voice Rate 

Command Description 

Ctrl  + Alt  + Page Down  Decrease Voice Rate 
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Command Description 

Ctrl  + Alt  + Page Up  Increase Voice Rate 

Page Down  Decrease Voice Rate (when using SayAll) 

Page Up  Increase Voice Rate (when using SayAll) 

Headings and Lists  

Command Description 

H  Headings Quick Key  

1-6  Headings level 1-6 

Insert  + F6  List of Headings 

L  List Quick Key  

I  List Item Quick Key  

Tables 

Moving within Tables 

Command Description 

T  Table Quick Key  

Ctrl  + Alt  +  Cell to Right 

Ctrl  + Alt  +  Cell to Left 

Ctrl  + Alt  +  Cell Below 

Ctrl  + Alt  +  Cell Above 

Ctrl  + Alt  + Home  First Cell 

Ctrl  + Alt +END Last Cell 

Ctrl  + Alt  + Shift  +  First Cell in Column 

Ctrl  + Alt  + Shift  +  Last Cell in Column 

Ctrl  + Alt  + Shift  +  First Cell in Row 

Ctrl  + Alt  + Shift  +  Last Cell in Row 

Table Reading 

Command Description 

Ctrl  + Alt +Num Pad 5  Say Current Cell 

Insert  + Shift  +  Read Current Row 

Insert  + Shift  + Home  Read from Start of Row 

Insert  + Shift  + Page Up  Read to End of Row 

Insert  + Shift +Num Pad 5  Read Current Column 

Insert  + Shift  + End Read from Top of Column 

Insert  + Shift  + Page Down  Read to Bottom of Column 
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Forms 

Command Description 

F  Form Quick Key 

B  Button Quick Key 

R  Radio Button 

Enter  (in a form element) Enter Forms Mode  

Tab  Navigate to Next Form Control  

Shift  + Tab  Navigate to Previous Form Control  

Spacebar  Select and Deselect Checkboxes 

Alt  +  Open Combo Box/Jump Menu  

Ctrl  + Shift  or Ctrl  + Spacebar Select Multiple List Items 

Ctrl + \  Unselect All But Current 

/  Select Radio Button  

/  or the First letter  Select Element in Combo Box  

Enter  (in forms mode)  Submit Form  

+  key Exit Forms Mode 

Insert  + F5  List of Form Elements 

Links 

Command Description 

Tab  Jump from link/Form element next one  

Shift  + Tab  Jump from link/Form element next previous one  

Ins  + F7  Bring up a list of links within the page 

U  Unvisited Link Quick Key  

V  Visited Link Quick Key  

Frames 

Command Description 

Ctrl  + Tab  Move from one frame to the next frame within the page. 

Ctrl  + Shift  + Tab  
Move from one frame to the previous frame within the 
page. 

Ins  + F9  Bring up a list of frames that are present within the page 

Other Commands 

Command Description 

Ctrl  + F  Search for a word or a phrase 

Ins  + Esc  Refresh Screen, i.e. repaint all the currently displayed 
items on the screen 
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Command Description 

Ins  + F5  Reformat documents, i.e. reformat multiple column 
pages to be more readable with speech 

Insert  + F1  Help with current element 

Shift + Tab and press  To read error message for “New” Search page 

Shift + Tab and press and again press  

 

To read error message for “Manage” Search page 

JAWS commands to open the document: 

 ‘Alt’ button will display shortcut keys. 

 Use ‘Alt + O’ to open the document. 

 ‘.doc’ or Word documents by default open in ‘Non-editable’ mode.  

 ‘Alt +S’ will enable the document to ‘Save’, displays message ‘Enable Saving’. 

o Clicking on ‘Enable Saving’ will open the document in edit mode. 

o Clicking on ‘Cancel’, will let the user remain on the same page in non-editable mode. 

Service Directory: 

To read and select multi select combo box: 

 Keyboard users can press the Internet Explorer keystroke SHIFT+F8 to turn on extended selection 
mode. While this mode is on, move up or down the list of choices and press SPACEBAR to select as 
many items as desired. To unselect a previously selected item, press SPACEBAR again on the item. 
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	Chapter 1: Virtual Gateway’s Provider Data Management (PDM) System 
	OVERVIEW 
	The Virtual Gateway is an Internet portal designed by the Executive Office of Health and Human Services (EOHHS) to provide the general public, medical providers, community-based organizations, and EOHHS staff with online access to health and human services. By consolidating information and online services in a single location on the Internet, the Virtual Gateway simplifies the process of connecting people to critical health and human services programs and information. 
	Provider Data Management is a web-based service that gives Purchase of Service (POS) providers and EOHHS agencies a single place to view and edit information commonly requested by Health and Human Services agencies.  The Provider Data Management System is a web based EOHHS application that supports:  
	1. State agencies within the Executive Office of Health and Human Services through a centralized location to view provider information required for contracting monitoring. 
	1. State agencies within the Executive Office of Health and Human Services through a centralized location to view provider information required for contracting monitoring. 
	1. State agencies within the Executive Office of Health and Human Services through a centralized location to view provider information required for contracting monitoring. 

	2. Provider organizations with whom EOHHS agencies contract by hosting a central repository of all Purchase of Service (POS) contracts, service data, forms and reports, and organizational profiles. 
	2. Provider organizations with whom EOHHS agencies contract by hosting a central repository of all Purchase of Service (POS) contracts, service data, forms and reports, and organizational profiles. 

	3. Annual Provider Qualification review process aimed at minimizing financial and administrative risk to the Commonwealth and the people served through the Purchase of Service system. 
	3. Annual Provider Qualification review process aimed at minimizing financial and administrative risk to the Commonwealth and the people served through the Purchase of Service system. 

	4. Creation of specialized reports and service directories designed to meet federal funding requirements and assist general public in identifying service providers. 
	4. Creation of specialized reports and service directories designed to meet federal funding requirements and assist general public in identifying service providers. 

	5. Special initiatives undertaken by the EHS to meet legislative directives. 
	5. Special initiatives undertaken by the EHS to meet legislative directives. 


	The PDM Business Service is intended to serve as a well-organized, easily navigated ‘filing system’ of provider data. It is important to note that the application requires both web-based data entry and population of the PDM data from external source systems. 
	PDM is an application built to manage providers servicing the Purchase of Service (POS) provider population. This enhanced functionality will support enrolling provider agencies and individual providers to provide different waiver program services. 
	Provider Management allows individual providers and provider agencies access to update their demographic information; and manage their services and qualifications in the system. Certain business rules apply in order to modify service related information especially when they are part of an existing plan and are currently providing services to consumers. Provider initiated service modifications and additions go through a review and approval process by the reviewers. 
	The Provider Data Management system has four primary pages.   
	 Information: The Information page stores information about a Provider such as Corporate Contact Information, Provider’s PDM Contact, Executive Contact, and general corporate information (Mission Statement and Corporate Description).   
	 Information: The Information page stores information about a Provider such as Corporate Contact Information, Provider’s PDM Contact, Executive Contact, and general corporate information (Mission Statement and Corporate Description).   
	 Information: The Information page stores information about a Provider such as Corporate Contact Information, Provider’s PDM Contact, Executive Contact, and general corporate information (Mission Statement and Corporate Description).   

	o Service Directory: Service Directory (SD) is a tool developed by the Massachusetts Department of Developmental Services (DDS) to assist individuals, families, support brokers, and clinical staff to locate services and service providers in the Commonwealth of Massachusetts. The SD helps clients to locate particular service providers, search for services and supports provided in their community and provide information about specific services funded by the Department of Developmental Services (DDS) under the
	o Service Directory: Service Directory (SD) is a tool developed by the Massachusetts Department of Developmental Services (DDS) to assist individuals, families, support brokers, and clinical staff to locate services and service providers in the Commonwealth of Massachusetts. The SD helps clients to locate particular service providers, search for services and supports provided in their community and provide information about specific services funded by the Department of Developmental Services (DDS) under the
	o Service Directory: Service Directory (SD) is a tool developed by the Massachusetts Department of Developmental Services (DDS) to assist individuals, families, support brokers, and clinical staff to locate services and service providers in the Commonwealth of Massachusetts. The SD helps clients to locate particular service providers, search for services and supports provided in their community and provide information about specific services funded by the Department of Developmental Services (DDS) under the

	o Service Directory will appear as a link on the Information page to Providers who have contracts/services with the Department of Developmental Services (DDS).  
	o Service Directory will appear as a link on the Information page to Providers who have contracts/services with the Department of Developmental Services (DDS).  

	o Visit the Service Directory page to find services and supports for clients and/or their family member. (
	o Visit the Service Directory page to find services and supports for clients and/or their family member. (
	o Visit the Service Directory page to find services and supports for clients and/or their family member. (
	https://service.hhs.state.ma.us/pdm4public/ssdHome.jsp
	https://service.hhs.state.ma.us/pdm4public/ssdHome.jsp

	) 



	 Qualification: The Qualification page stores information about the POS Provider’s qualifications such as Principle Purchasing Agency (PPA), Qualification Status, UFR Filing Period reviewed, Date UFR Received by OSD, Date Qualification Status Last Updated, Concerns/Issues, and Comments.  The Qualification Page has two links: 
	 Qualification: The Qualification page stores information about the POS Provider’s qualifications such as Principle Purchasing Agency (PPA), Qualification Status, UFR Filing Period reviewed, Date UFR Received by OSD, Date Qualification Status Last Updated, Concerns/Issues, and Comments.  The Qualification Page has two links: 

	o Financial Ratios: The Financial Ratios page assists agencies in assessing the financial stability of a provider.  The EOHHS Purchase of Service (POS) Integrity Unit established the standard Financial Assessment Measures and benchmarks. The Financial Ratios page is pre-populated when the Operational Services Division (OSD) receives a provider’s annual Uniform Financial Report (UFR) and parses the information into the OSD database.   
	o Financial Ratios: The Financial Ratios page assists agencies in assessing the financial stability of a provider.  The EOHHS Purchase of Service (POS) Integrity Unit established the standard Financial Assessment Measures and benchmarks. The Financial Ratios page is pre-populated when the Operational Services Division (OSD) receives a provider’s annual Uniform Financial Report (UFR) and parses the information into the OSD database.   
	o Financial Ratios: The Financial Ratios page assists agencies in assessing the financial stability of a provider.  The EOHHS Purchase of Service (POS) Integrity Unit established the standard Financial Assessment Measures and benchmarks. The Financial Ratios page is pre-populated when the Operational Services Division (OSD) receives a provider’s annual Uniform Financial Report (UFR) and parses the information into the OSD database.   

	o Corrective Measures: The Corrective Measures page displays, by PQ Fiscal Year, the UFR Audit Findings, the Corrective Action Plan, and Audit Records (OSA Audit).   
	o Corrective Measures: The Corrective Measures page displays, by PQ Fiscal Year, the UFR Audit Findings, the Corrective Action Plan, and Audit Records (OSA Audit).   


	 Contract Detail: The Contract Detail page stores information about the POS Provider’s contracts for the current fiscal year such as Activity Code, Activity Name, Doc ID, Object Code, Maximum Contract Obligation, Expended to Date, and Unexpended Amount.  For Release 5.0 PDM will only display contracts with Object Codes MM3 and M03. 
	 Contract Detail: The Contract Detail page stores information about the POS Provider’s contracts for the current fiscal year such as Activity Code, Activity Name, Doc ID, Object Code, Maximum Contract Obligation, Expended to Date, and Unexpended Amount.  For Release 5.0 PDM will only display contracts with Object Codes MM3 and M03. 


	Note: The information found under the Contract Details tab is sourced from the Commonwealth’s Information Warehouse.  Information about services offered, but not contracted through EOHHS is entered by the provider. 
	 Surplus Revenue: The Surplus Revenue page is primarily used by the Principal Purchasing Agency (PPA) to record and retain an account of the surplus revenue liability based on the Annual SSR of 5% limit.  
	 Surplus Revenue: The Surplus Revenue page is primarily used by the Principal Purchasing Agency (PPA) to record and retain an account of the surplus revenue liability based on the Annual SSR of 5% limit.  
	 Surplus Revenue: The Surplus Revenue page is primarily used by the Principal Purchasing Agency (PPA) to record and retain an account of the surplus revenue liability based on the Annual SSR of 5% limit.  


	Security roles determine what a user can view and edit in PDM.  Refer to Appendix B: PDM Security Matrix for a listing of security roles.  
	More information about PDM can be found via the EOHHS Virtual Gateway: 
	More information about PDM can be found via the EOHHS Virtual Gateway: 
	www.mass.gov/vg/pdm
	www.mass.gov/vg/pdm

	.  

	SYSTEM REQUIREMENTS 
	All computers used to access the Virtual Gateway require Internet Explorer 6.0 or higher. For the PDM application, the minimum system requirements are the following. 
	• Windows (2000 or XP Professional) 
	• Windows (2000 or XP Professional) 
	• Windows (2000 or XP Professional) 

	• Internet Explorer 7.0 or 8.0 
	• Internet Explorer 7.0 or 8.0 

	• 1280x960 screen resolution 
	• 1280x960 screen resolution 

	• 300MHz CPU and 128MB RAM 
	• 300MHz CPU and 128MB RAM 


	Additionally, the preferred system features to enhance the performance of PDM are the following. 
	• Windows XP Professional 
	• Windows XP Professional 
	• Windows XP Professional 

	• 1440x900 screen resolution 
	• 1440x900 screen resolution 

	• 500MHz CPU and 256MB RAM 
	• 500MHz CPU and 256MB RAM 


	Acceptable Alternatives: 
	• Browsers: Firefox 
	• Browsers: Firefox 
	• Browsers: Firefox 

	• Compatible with Dragon and JAWS 
	• Compatible with Dragon and JAWS 


	Note: Java Script is required and must be enabled to use the PDM application. To enable JAVA Script, follow the steps below. 
	Enable JAVA scripting on IE 7.0, IE 8.0 
	• From the Tools menu, or the Tools drop-down in the upper right, choose Internet options. 
	• From the Tools menu, or the Tools drop-down in the upper right, choose Internet options. 
	• From the Tools menu, or the Tools drop-down in the upper right, choose Internet options. 
	• From the Tools menu, or the Tools drop-down in the upper right, choose Internet options. 
	• From the Tools menu, or the Tools drop-down in the upper right, choose Internet options. 

	• Click the Security tab, and then click Custom Level. 
	• Click the Security tab, and then click Custom Level. 

	• Scroll to the “Scripting” section of the list. For “Active Scripting,” click Enable. 
	• Scroll to the “Scripting” section of the list. For “Active Scripting,” click Enable. 

	• Click OK, and confirm if prompted. 
	• Click OK, and confirm if prompted. 

	• Close and restart your browser.  
	• Close and restart your browser.  




	Enable JAVA scripting on Firefox 
	• From the Tools menu, select Options. 
	• From the Tools menu, select Options. 
	• From the Tools menu, select Options. 
	• From the Tools menu, select Options. 
	• From the Tools menu, select Options. 

	• Click Content. 
	• Click Content. 

	• Check or uncheck Enable Java Script and Enable Java. 
	• Check or uncheck Enable Java Script and Enable Java. 




	Note:  If a lower screen resolution is selected, then the user needs to select the “Smaller” text size. 
	 Select the View menu from the Internet Explorer browser. 
	 Select the View menu from the Internet Explorer browser. 
	 Select the View menu from the Internet Explorer browser. 

	 Select Text Size>>Smaller. 
	 Select Text Size>>Smaller. 
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	Chapter 2: Getting Started 
	ACCESSING PDM ON THE VIRTUAL GATEWAY (VG) 
	Select the link: 
	Select the link: 
	Virtual Gateway Login Assistance Page
	Virtual Gateway Login Assistance Page

	 for more information on accessing the Virtual Gateway. 

	1. To use the Virtual Gateway's PDM system, users must log on to the Virtual Gateway at 
	1. To use the Virtual Gateway's PDM system, users must log on to the Virtual Gateway at 
	1. To use the Virtual Gateway's PDM system, users must log on to the Virtual Gateway at 
	1. To use the Virtual Gateway's PDM system, users must log on to the Virtual Gateway at 
	https://gateway.hhs.state.ma.us/authn/login.do
	https://gateway.hhs.state.ma.us/authn/login.do

	. 



	 
	Figure 1: Welcome to the Virtual Gateway page. 
	From the Welcome to the Virtual Gateway page: 
	2. Enter your VG Username and Password.  
	2. Enter your VG Username and Password.  
	2. Enter your VG Username and Password.  


	From the VG Business Service page:  
	3. Select the Provider Data Management link.  
	3. Select the Provider Data Management link.  
	3. Select the Provider Data Management link.  


	 
	  Figure 2: Virtual Gateway Business Service page. 
	Notes:  
	 If logging on for the first time, refer to your New User Email for Username and temporary password.  
	 If logging on for the first time, refer to your New User Email for Username and temporary password.  
	 If logging on for the first time, refer to your New User Email for Username and temporary password.  

	LI
	LBody
	Span
	
	 
	Refer to the 
	Virtual Gateway Login Assistance
	Virtual Gateway Login Assistance

	 (
	http://www.mass.gov/eohhs/provider/training-and-edu/vg/login-help-for-providers-and-state-agency-staff.html
	http://www.mass.gov/eohhs/provider/training-and-edu/vg/login-help-for-providers-and-state-agency-staff.html

	) page for additional guidance on logging on to the Virtual Gateway and account maintenance.   



	PDM Welcome Page 
	The Welcome to the Provider Data Management Information System page appears.  
	 
	Figure 3: Welcome to the Provider Data Management Information System page. 
	  
	The options available from the PDM Home Page are briefly described in the table below: 
	Table
	TR
	TH
	Span
	Menu Option 

	TH
	Span
	Description 

	Span

	Manage Provider 
	Manage Provider 
	Manage Provider 

	This option will redirect the user to the applicable page based on the assigned security role of the user and allow user to view qualified provider information about the current services that are being provided.   
	This option will redirect the user to the applicable page based on the assigned security role of the user and allow user to view qualified provider information about the current services that are being provided.   

	Span

	Help 
	Help 
	Help 

	This option will redirect the user to the PDM User Guide documentation.  This documentation is available in Word and PDF format. 
	This option will redirect the user to the PDM User Guide documentation.  This documentation is available in Word and PDF format. 

	Span

	Logoff 
	Logoff 
	Logoff 

	Exits PDM and redirects the user to the Virtual Gateway Home Page. 
	Exits PDM and redirects the user to the Virtual Gateway Home Page. 

	Span


	Virtual Gateway Customer Service 
	The Virtual Gateway Customer Service provides login and technical assistance to providers and state Agency staff. 
	If you have questions on accessing PDM on the Virtual Gateway, contact Virtual Gateway Customer Service for assistance.  
	 800-421-0938 (Voice) 
	 800-421-0938 (Voice) 
	 800-421-0938 (Voice) 

	 617-847-6578 (TTY for people who are deaf, hard of hearing, or speech disabled) 
	 617-847-6578 (TTY for people who are deaf, hard of hearing, or speech disabled) 

	 Monday through Friday (8:30 a.m. to 5:00 p.m.) 
	 Monday through Friday (8:30 a.m. to 5:00 p.m.) 


	Questions about the PDM Program 
	If you have any questions regarding PDM or this application please contact the PDM project office via 
	If you have any questions regarding PDM or this application please contact the PDM project office via 
	EHS-DL-PDMITTeam@MassMail.State.MA.US
	EHS-DL-PDMITTeam@MassMail.State.MA.US

	.  
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	Chapter 3: Principal Purchasing Agency (PPA) and Agency Observer Roles 
	OVERVIEW 
	Principal Purchasing Agency (PPA): The Principal Purchasing Agency (PPA) role allows agency staff to edit and view provider information. This role can also enter information that supports the POS provider evaluation and annual prequalification process; and access predefined agency reports. 
	Agency Observer: This role allows designated agency staff to view only Provider information and access predefined reports. 
	Table
	TR
	TH
	Span
	PDM Role 

	TH
	Span
	Information 

	TH
	Span
	Qualifications 
	(Including Financial Ratio and Corrective Measures) 

	TH
	Span
	Contract Detail 

	TH
	Span
	Surplus Revenue 

	Span

	Principal Purchasing Agency (PPA)  
	Principal Purchasing Agency (PPA)  
	Principal Purchasing Agency (PPA)  

	View 
	View 

	View/Edit 
	View/Edit 

	View 
	View 

	View/Edit 
	View/Edit 
	 

	Span

	Agency Observer 
	Agency Observer 
	Agency Observer 

	View 
	View 

	View 
	View 

	View 
	View 

	View 
	View 

	Span


	Reminders When Using PDM: 
	 All fields denoted with an asterisk (*) are required fields and must be completed in order to save the record. 
	 All fields denoted with an asterisk (*) are required fields and must be completed in order to save the record. 
	 All fields denoted with an asterisk (*) are required fields and must be completed in order to save the record. 

	 Do not save a record until all sections are completed. If the user tries to save before completing all required fields within each section, the user will receive error messages at the top of the page listing the missing data. 
	 Do not save a record until all sections are completed. If the user tries to save before completing all required fields within each section, the user will receive error messages at the top of the page listing the missing data. 

	 If you attempt to navigate to another page while in Edit mode without first saving you will receive a warning message (different text depending on the web browser you are working in) such as: 
	 If you attempt to navigate to another page while in Edit mode without first saving you will receive a warning message (different text depending on the web browser you are working in) such as: 

	o Firefox: “This page is asking you to confirm that you want to leave – data you have entered may not be saved.” 
	o Firefox: “This page is asking you to confirm that you want to leave – data you have entered may not be saved.” 
	o Firefox: “This page is asking you to confirm that you want to leave – data you have entered may not be saved.” 

	o Internet Explorer: “Are you sure you want to navigate away from this page?  This page is asking you to confirm that you want to leave – data you have entered may not be saved.  Press OK to continue, or Cancel to stay on the current page.” 
	o Internet Explorer: “Are you sure you want to navigate away from this page?  This page is asking you to confirm that you want to leave – data you have entered may not be saved.  Press OK to continue, or Cancel to stay on the current page.” 



	For guidance on using JAWS with PDM, refer to Appendix B: JAWS Commands.   
	PROVIDER SEARCH 
	The Principal Purchasing Agency (PPA) and Agency Observer both have the ability to search for providers.  It is important to know how to search for providers within the database.  The search page allows the user to search for an existing Provider in order to manage or view (dependent on role) an existing provider who is active for the current PQ year and who has had a contract with the Commonwealth in the past five years. 
	Using a name, FEIN or an alphabetical listing the search engine conducts a search of the database to display a provider’s profile.  
	The Search page is accessed by selecting Manage Provider from the Navigation menu.  
	 
	Figure 4: Welcome to the Provider Data Management System page. 
	The Provider Search page allows users to search for entries in two ways: 
	 Search By Provider 
	 Search By Provider 
	 Search By Provider 

	 Search Alphabetically 
	 Search Alphabetically 


	 
	Figure 5: Provider Search page. 
	Search By Provider 
	1. Select the Search By Provider radio button. 
	1. Select the Search By Provider radio button. 
	1. Select the Search By Provider radio button. 

	2. Select the Search button. 
	2. Select the Search button. 


	 
	Figure 6: Searching by Provider option. 
	Note: The Provider Search page allows users to search for records in three ways.  Users can search by using one option or a combination of options. 
	 FEIN (Federal Employment Identification Number) 
	 FEIN (Federal Employment Identification Number) 
	 FEIN (Federal Employment Identification Number) 

	 Name (Provider Name) 
	 Name (Provider Name) 

	 PPA (Principal Purchasing Agency) 
	 PPA (Principal Purchasing Agency) 

	1. Type the Name. (Full or Partial name). 
	1. Type the Name. (Full or Partial name). 


	There are three buttons under the Provider Search section: 
	 Search: To conduct a search per entered criteria. 
	 Search: To conduct a search per entered criteria. 
	 Search: To conduct a search per entered criteria. 

	 Clear: To clear criteria from fields. 
	 Clear: To clear criteria from fields. 

	 Return: To return to the Search option page. 
	 Return: To return to the Search option page. 

	2. Select the Search button 
	2. Select the Search button 


	The Provider Search page returns with results based off of entered criteria.  
	 
	Figure 7: Provider Search page returns with results based off of entered criteria. 
	Note: Wildcard Search, the * (asterisk) can be used as a wildcard in the name field to search for a provider. If you are unsure of the full name of the provider,  or want to see all the options using a portion of a name , use the wild card to search. (i.e. *key will produce Catherine Key, Berkshire* will produce Berkshire Community Center etc., *education* will produce any provider who has the word education in their organization name.) 
	3. Select record to view. The user will be redirected to the PDM Information page. 
	3. Select record to view. The user will be redirected to the PDM Information page. 
	3. Select record to view. The user will be redirected to the PDM Information page. 


	Search Alphabetically 
	1. Select Search Alphabetically radio button. 
	1. Select Search Alphabetically radio button. 
	1. Select Search Alphabetically radio button. 

	2. Select the Search button. 
	2. Select the Search button. 


	 
	Figure 8: Provider Search - Search Alphabetically. 
	3. Select the Select drop down menu to select the corresponding letter for the Provider Name. 
	3. Select the Select drop down menu to select the corresponding letter for the Provider Name. 
	3. Select the Select drop down menu to select the corresponding letter for the Provider Name. 

	4. Select the Search button. 
	4. Select the Search button. 


	 
	Figure 9: Provider Search - Search Alphabetically by Provider Name. 
	The Provider Search page returns with results based off of entered criteria.  
	 
	Figure 10: Search Alphabetically - The Provider Search page returns with results based off of entered criteria. 
	5. Select record to view. The user will be redirected to the PDM Information page. 
	5. Select record to view. The user will be redirected to the PDM Information page. 
	5. Select record to view. The user will be redirected to the PDM Information page. 


	  
	PDM Information Page 
	The PDM Information page contains demographic information about the selected provider and displays the following information: 
	 Corporate Contact Information  
	 Corporate Contact Information  
	 Corporate Contact Information  

	 Provider’s PDM Contact 
	 Provider’s PDM Contact 

	 Executive Contacts 
	 Executive Contacts 

	 General Corporate Information 
	 General Corporate Information 


	Users assigned the Principal Purchasing Agency (PPA) and Agency Observer roles have View only rights on the Information page.   
	The Information page has the following button located at the bottom of the page: 
	 Return to Search: Returns user to the Provider Search page. 
	 Return to Search: Returns user to the Provider Search page. 
	 Return to Search: Returns user to the Provider Search page. 


	 
	Figure 11: PDM Information page. 
	PDM Qualification Page 
	The PDM Qualification page is populated when the EOHHS Principal Purchasing Agency (PPA) Provider Qualification Officer (PQO) completes the review process.   The PDM system calculates these fields using data from Provider’s UFR filing from OSD data feed and cannot be edited.  
	A user assigned the Principal Purchasing Agency (PPA) role can edit specific data fields on this page. 
	A user assigned the Agency Observer role has View only rights. 
	 
	Figure 12: PDM Qualification page. 
	Qualification – Viewing PQ Year 
	PDM maintains the current PQ year along with previous years.  The Qualifications page defaults to the current PQ Year.  To view a prior year,  
	1. Select the PQ Year drop down arrow and select the Year to be viewed.  
	1. Select the PQ Year drop down arrow and select the Year to be viewed.  
	1. Select the PQ Year drop down arrow and select the Year to be viewed.  

	2. Select the Update button. 
	2. Select the Update button. 


	 
	Figure 13: Under the Qualifications page, changing the PQ Year to 2011 and selecting the Update button. 
	Note: Each time the PQ Year is selected it must be followed by selecting the update button to ensure all data is up to date per the selection. 
	A user with the Principal Purchasing Agency (PPA) role can edit the following sections on the Qualifications page: 
	• Qualification Status 
	• Qualification Status 
	• Qualification Status 

	• Concerns / Issues 
	• Concerns / Issues 

	• Comments 
	• Comments 

	1. Select the Edit button at the bottom of the page. 
	1. Select the Edit button at the bottom of the page. 


	 
	Figure 14: Selecting the Edit button on the Qualification page. 
	Parent/Child/Affiliate Providers 
	The Parent/Child/Affiliate Providers section allows the Principal Purchasing Agency (PPA) and Agency Observer to view the other providers associated to this provider.  
	Note: Parent/Child/Affiliate Providers information will only be visible if the Provider has Child or Affiliate Providers. 
	 
	Figure 15: Parent/Child/Affiliate Providers section under the Qualification page. 
	1. Select record to view. The user will be redirected to the PDM Information page for that provider organization. 
	1. Select record to view. The user will be redirected to the PDM Information page for that provider organization. 
	1. Select record to view. The user will be redirected to the PDM Information page for that provider organization. 


	Status 
	The Status section allows the PPA to update the Qualification Status.   
	To update the Qualification Status field, 
	1. Select the Qualification Status drop down arrow and select one of the following options: 
	1. Select the Qualification Status drop down arrow and select one of the following options: 
	1. Select the Qualification Status drop down arrow and select one of the following options: 

	 Conditional 
	 Conditional 
	 Conditional 

	 Limited 
	 Limited 

	 No POS Business 
	 No POS Business 

	 Pending 
	 Pending 

	 Provisional 
	 Provisional 

	 Public Entity 
	 Public Entity 

	 Qualification with CAP 
	 Qualification with CAP 

	 Rejected 
	 Rejected 

	 Unconditional 
	 Unconditional 


	2. Select the Save button. 
	2. Select the Save button. 


	 
	Figure 16: Status section under the Qualification page. 
	  
	Concerns/Issues  
	A user with the Principal Purchasing Agency (PPA) role can edit the Concerns/Issues section.  If a checkmark is placed in any one of the checkboxes, the user will need to add an explanation one the Corrective Measures page.  Refer to the Corrective Measures in this chapter for more information. 
	 
	Figure 17: Concerns/Issues section on the Qualification page. 
	Comments 
	A user with the Principal Purchasing Agency (PPA) role can add /delete comments in this section. 
	To Add a Comment: 
	1. Type the Comments you desire in the Comment field. 
	1. Type the Comments you desire in the Comment field. 
	1. Type the Comments you desire in the Comment field. 

	2. Select the Save button. 
	2. Select the Save button. 


	The comment will display in the comments dialog box. 
	To Delete a Comment: 
	1. Select the Delete link. 
	1. Select the Delete link. 
	1. Select the Delete link. 

	2. Select the Save button. 
	2. Select the Save button. 


	Note:  Only the author can edit and/or delete his or her own comments. 
	The graphic below represents comments added along with highlighting the Delete option. 
	 
	Figure 18: Comments section on the Qualification page. 
	Note:  A reminder that if you navigate away from any page while in Edit mode without saving, PDM will prompt a Warning screen. 
	 
	 
	  
	PDM Qualification – Financial Ratios 
	The Financial Ratios page contains vital financial ratios for current and past two years. 
	1. Select the Financial Ratios link 
	1. Select the Financial Ratios link 
	1. Select the Financial Ratios link 


	 
	Figure 19: Highlighting the Financial Ratios page from the Qualification page. 
	The Financial Ratios page displays the last 3 fiscal years prior to the PQ year selected. 
	1. Select any one of the links in the first column to open the Financial Ratios Definitions page. 
	1. Select any one of the links in the first column to open the Financial Ratios Definitions page. 
	1. Select any one of the links in the first column to open the Financial Ratios Definitions page. 


	 
	Figure 20: Financial Ratios page which is under Qualification. 
	2. Select Back to open the Financial Ratios page or select Return to search to open the Provider Search page. 
	2. Select Back to open the Financial Ratios page or select Return to search to open the Provider Search page. 
	2. Select Back to open the Financial Ratios page or select Return to search to open the Provider Search page. 


	PDM Qualification – Corrective Measures 
	The Corrective Measures page is part of Provider Profile and contains corrective measures. 
	Under the UFR Audit Findings section, if the Status field has a ‘YES’ this indicates that a checkmark was entered selected under the Qualification page for the Internal Control, Compliance, Financial Ratios, Management Letter, Notes to Financials, or Other.  While an optional field, it is recommended that the PPA enter an explanation under UFR Audit Findings when the status is ‘YES’.  
	1. Select Edit at the bottom of the page. 
	1. Select Edit at the bottom of the page. 
	1. Select Edit at the bottom of the page. 


	 
	Figure 21: Corrective Measures page highlighting the Concerns/Issues section which requires explanation when "Yes" is displayed. 
	2. Type an explanation for each Concerns/Issues with a ‘Yes’ in the Status field. 
	2. Type an explanation for each Concerns/Issues with a ‘Yes’ in the Status field. 
	2. Type an explanation for each Concerns/Issues with a ‘Yes’ in the Status field. 

	3. Select the Save button. 
	3. Select the Save button. 


	 
	Figure 22: Completed Concerns/Issues section under Corrective Measures page. 
	The Corrective Action Plan is updated by data on the UFR and by OSD/CIW.  This is a View only section. 
	 
	Figure 23: Corrective Action Plan section under the Corrective Measures page. 
	The Audit Records (OSA AUDIT) section can be updated by the PPA. 
	1. Type the Audit Number. 
	1. Type the Audit Number. 
	1. Type the Audit Number. 

	2. Type the Issue Date. (Format: DD/MM/YYYY or  
	2. Type the Issue Date. (Format: DD/MM/YYYY or  

	3. Select the CAP Status. (Options: Open or Close) 
	3. Select the CAP Status. (Options: Open or Close) 

	4. Type the Audit Resolution Summary. 
	4. Type the Audit Resolution Summary. 

	5. Select Financial Audit Findings.  (Options: Yes or No) 
	5. Select Financial Audit Findings.  (Options: Yes or No) 

	6. Select the Add Audit Record. 
	6. Select the Add Audit Record. 


	 
	Figure 24: Audit Records (OSA Audit) section under the Corrective Measures page. 
	  
	PDM CONTRACT DETAILS 
	The Contract Detail page stores information about the POS Provider’s contracts for the current fiscal year such as Activity Code, Activity Name, Doc ID, Object Code, Maximum Contract Obligation, Expended to Date, and Unexpended Amount.  For Release 5.0 PDM will only display contracts with Object Codes MM3 and M03. 
	The Principal Purchasing Agency (PPA) and Agency Observer roles allow designated staff from within the organization to view this page.  These roles do not have Edit rights on this page. 
	Note: The information found under Contract Details is sourced from the Commonwealth’s Information Warehouse.  Information about services offered, but not contracted through EOHHS is entered by the provider. 
	This page provides the Purchasing Agency (PPA) and Agency Observer with a snapshot of all of current year contracts, by EOHHS agency. 
	 
	Figure 25: Contract Detail page lists all contracts a provider has with EOHHS agencies. 
	PDM SURPLUS REVENUE 
	The Surplus Revenue page is primarily used by the Principal Purchasing Agency (PPA) to record and retain an account of the surplus revenue liability based on the Annual SSR of 5% limit. If an excess 5% Surplus Revenue Liability exists, the Principal Purchasing Agency utilizes the corresponding fields below to provide an accounting of the negotiation with the Provider to satisfy the liability owed the Commonwealth.  
	 
	Figure 26: PDM Surplus Revenue page. 
	The Principal Purchasing Agency (PPA) can edit the following fields on the Surplus Revenue page: 
	 Date of Agency/Provider Agreement 
	 Date of Agency/Provider Agreement 
	 Date of Agency/Provider Agreement 

	 Cash Reimbursement 
	 Cash Reimbursement 

	 Free Care 
	 Free Care 

	 Adjusted Unit Rate Contract 
	 Adjusted Unit Rate Contract 

	 Other (*notes in comments) 
	 Other (*notes in comments) 

	 Costs Offset Refiled UFR 
	 Costs Offset Refiled UFR 

	 Estimated Date Reimbursement will be completed 
	 Estimated Date Reimbursement will be completed 

	 Date Reimbursement completed 
	 Date Reimbursement completed 

	 Comments 
	 Comments 


	After entering in the information, the PPA selects the Save button. 
	 
	Figure 27: PDM Surplus Revenue page in Edit mode. 
	  
	Chapter 4: POS Program Operations Role 
	OVERVIEW 
	This role allows POS Operations staff to Add and Manage Providers in the system. This role also has access to edit capability and the ability to assign PPAs.  In addition this role has access to the reports menu. 
	POS Program Operations This role allows POS Program Operations access the provider PDM records. POS Program Operations with this access have the capability to edit and update information. 
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	Reminders When Using PDM: 
	 All fields denoted with an asterisk (*) are required fields and must be completed in order to save the record. 
	 All fields denoted with an asterisk (*) are required fields and must be completed in order to save the record. 
	 All fields denoted with an asterisk (*) are required fields and must be completed in order to save the record. 

	 Do not save a record until all sections are completed. If the user tries to save before completing all required fields within each section, the user will receive error messages at the top of the page listing the missing data. 
	 Do not save a record until all sections are completed. If the user tries to save before completing all required fields within each section, the user will receive error messages at the top of the page listing the missing data. 

	 If you attempt to navigate to another page while in Edit mode without first saving you will receive a warning message (different text depending on the web browser you are working in) such as: 
	 If you attempt to navigate to another page while in Edit mode without first saving you will receive a warning message (different text depending on the web browser you are working in) such as: 

	o Firefox: “This page is asking you to confirm that you want to leave – data you have entered may not be saved.” 
	o Firefox: “This page is asking you to confirm that you want to leave – data you have entered may not be saved.” 
	o Firefox: “This page is asking you to confirm that you want to leave – data you have entered may not be saved.” 

	o Internet Explorer: “Are you sure you want to navigate away from this page?  This page is asking you to confirm that you want to leave – data you have entered may not be saved.  Press OK to continue, or Cancel to stay on the current page.” 
	o Internet Explorer: “Are you sure you want to navigate away from this page?  This page is asking you to confirm that you want to leave – data you have entered may not be saved.  Press OK to continue, or Cancel to stay on the current page.” 



	For guidance on using JAWS with PDM, refer to Appendix B: JAWS Commands. 
	  
	PROVIDER SEARCH 
	A user with the POS Program Operations role has the ability to search for providers.  It is important to know how to search for providers within the database.  The search page allows the user to search for an existing Provider in order to manage or view (dependent on role) an existing provider who is active for the current PQ year and who has had a contract with the Commonwealth in the past five years. 
	Using a name, a portion of a name or an alphabetical listing the search engine conducts a search of the database to display a provider’s profile.  
	The Search page is accessed by selecting Manage Provider from the Navigation menu.  
	 
	Figure 28: Welcome to the Provider Data Management Information System page. 
	The Provider Search page allows users to search for entries in two ways: 
	 Search By Provider 
	 Search By Provider 
	 Search By Provider 

	 Search Alphabetically 
	 Search Alphabetically 


	 
	Figure 29: Provider Search page 
	Search By Provider 
	1. Select the Search By Provider radio button. 
	1. Select the Search By Provider radio button. 
	1. Select the Search By Provider radio button. 

	2. Select the Search button. 
	2. Select the Search button. 


	 
	Figure 30: Searching by Provider option. 
	Note: The Provider Search page allows users to search for records in three ways.  Users can search by using one option or a combination of options. 
	 FEIN # (Federal Employment Identification Number) 
	 FEIN # (Federal Employment Identification Number) 
	 FEIN # (Federal Employment Identification Number) 

	 Name (Provider Name) 
	 Name (Provider Name) 

	 PPA (Principal Purchase Agency) 
	 PPA (Principal Purchase Agency) 

	3. Type the Name. (Full or Partial name). 
	3. Type the Name. (Full or Partial name). 


	There are three buttons under the Provider Search section: 
	 Search: To conduct a search per entered criteria. 
	 Search: To conduct a search per entered criteria. 
	 Search: To conduct a search per entered criteria. 

	 Clear: To clear criteria from fields. 
	 Clear: To clear criteria from fields. 

	 Return: To return to the Search option page. 
	 Return: To return to the Search option page. 


	 
	4. Select the Search button. 
	4. Select the Search button. 
	4. Select the Search button. 


	The search results page open.  
	 
	Figure 31: Provider Search page returns with results based off of entered criteria 
	5. Select record to view. The user will be redirected to the PDM Information page. 
	5. Select record to view. The user will be redirected to the PDM Information page. 
	5. Select record to view. The user will be redirected to the PDM Information page. 


	Note: Wildcard Search, the * (asterisk) can be used as a wildcard in the name field to search for a provider. If you are unsure of the full name of the provider,  or want to see all the options using a portion of a name , use the wild card to search. (i.e. *key will produce Catherine Key, Berkshire* will produce Berkshire Community Center etc., *education* will produce any provider who has the word education in their organization name.) 
	Search Alphabetically 
	1. Select Search Alphabetically radio button. 
	1. Select Search Alphabetically radio button. 
	1. Select Search Alphabetically radio button. 

	2. Select the Search button. 
	2. Select the Search button. 


	 
	Figure 32: Provider Search - Search Alphabetically 
	3. Select the Select drop down menu to select the corresponding letter for the Provider Name. 
	3. Select the Select drop down menu to select the corresponding letter for the Provider Name. 
	3. Select the Select drop down menu to select the corresponding letter for the Provider Name. 

	4. Select the Search button. 
	4. Select the Search button. 


	 
	Figure 33: Provider Search - Search Alphabetically by Provider Name. 
	The Provider Search page returns with results based off of entered criteria.  
	 
	Figure 34: Search Alphabetically - The Provider Search page returns with results based off of entered criteria. 
	 
	5. Select record to view. The user will be redirected to the PDM Information page. 
	5. Select record to view. The user will be redirected to the PDM Information page. 
	5. Select record to view. The user will be redirected to the PDM Information page. 


	  
	PDM INFORMATION 
	The Information page stores demographic information about a Provider such as Corporate Contact Information, Provider’s PDM Contact, Executive Contact, and General Corporate Information (Mission Statement and Corporate Description).   
	After a user with the POS Program Operation role searches for and selects a provider record they are redirected to the PDM Information page. 
	Users assigned the POS Program Operations role have View and Edit rights on the Information page.   
	The Information page has two buttons located at the bottom of the page: 
	 Edit: The Edit button will appear for users with the PDM Contracted Providers Operations role. 
	 Edit: The Edit button will appear for users with the PDM Contracted Providers Operations role. 
	 Edit: The Edit button will appear for users with the PDM Contracted Providers Operations role. 

	 Return to Search: Returns user to the Provider Search page. 
	 Return to Search: Returns user to the Provider Search page. 


	 
	Figure 35: PDM Information page. 
	Corporate Contact Information  
	Under Corporate Contact Information the following fields can be edited by a user with the POS Program  Operation role: 
	 Alternate Address 
	 Alternate Address 
	 Alternate Address 

	 Phone, Fax 
	 Phone, Fax 

	 Email, Website 
	 Email, Website 


	Note: The Provider Name, FEIN and Legal Address fields are not editable. This data comes from the Commonwealth’s Information Warehouse (CIW). 
	 
	Figure 36: Fields that can be updated on Information > Corporate Contact Information section of the Information page. 
	If only updates to the Corporate Contact Information section are needed, select the Save button at the bottom of the page. 
	Provider’s PDM Contact 
	Under Provider’s PDM Contact the following fields can be edited by a user with the POS Program Operation role: 
	 First, Middle, and Last  
	 First, Middle, and Last  
	 First, Middle, and Last  

	 Phone, Email, Fax 
	 Phone, Email, Fax 


	 
	Figure 37: Fields that can be updated on Information > Provider's PDM Contact section of the Information page. 
	If only updates to the Provider’s PDM Contact section are needed, select the Save button at the bottom of page. 
	  
	Executive Contacts 
	Under Executive Contacts > CEO/Executive Director the following fields can be edited by a user with the POS Program Operation role: 
	 First, Middle, and Last  
	 First, Middle, and Last  
	 First, Middle, and Last  

	 Phone, Email 
	 Phone, Email 


	Under Executive Contacts > Chief Financial Officer the following fields can be edited by a user with the POS Program Operation role: 
	 First, Middle, and Last  
	 First, Middle, and Last  
	 First, Middle, and Last  

	 Phone, Email 
	 Phone, Email 


	 
	Figure 38: Fields that can be updated on Information > Executive Contacts section of the Information page. 
	If only updates to the Executive Contacts section are needed, select the Save button at the bottom of page. 
	General Corporate Information/ Mission Statement 
	Under General Corporate Information the following field can be edited by a user with the POS Program Operation role: 
	 Mission Statement 
	 Mission Statement 
	 Mission Statement 

	 Corporate Description 
	 Corporate Description 


	 
	Figure 39: Fields that can be updated on Information > General Corporate Information section on the Information page. 
	If only updates to the General Corporate Information section are needed, select the Save button at the bottom of page. 
	PDM Qualification 
	The PDM Qualification page is populated when the EOHHS Principal Purchasing Agency (PPA) Provider Qualification Officer (PQO) completes the review process.   The PDM system calculates the financial ratios field using data from Provider’s UFR filing from OSD data feed and cannot be edited.  
	 
	Figure 40: PDM Qualification page. 
	Qualification – Viewing PQ Year 
	PDM maintains the current PQ year along with previous years.  The Qualifications page defaults to the current PQ Year.   
	To view a prior PQ Year,  
	1. Select the PQ Year drop down arrow and select the Year to be viewed.  
	1. Select the PQ Year drop down arrow and select the Year to be viewed.  
	1. Select the PQ Year drop down arrow and select the Year to be viewed.  

	2. Select the Update button. 
	2. Select the Update button. 


	 
	Figure 41: Under the Qualifications page, changing the PQ Year to 2011 and selecting the Update button. 
	Note: Each time the PQ Year is selected it must be followed by selecting the update button to ensure all data is up to date per the selection. 
	The Qualification page now displays the data corresponding to PQ Year 2011.   
	A user assigned the POS Program Operation role can update the following fields: 
	• PPA, MEP Status, Qualification Status  
	• PPA, MEP Status, Qualification Status  
	• PPA, MEP Status, Qualification Status  

	• Concerns / Issues, Comments 
	• Concerns / Issues, Comments 

	3. Select the Edit button at the bottom of the page. 
	3. Select the Edit button at the bottom of the page. 


	 
	Figure 42: Selecting the Edit button on the Qualification page. 
	  
	Qualification 
	Under the Qualification section, a user with the POS Program Operation role can edit and update the following fields: 
	 PPA (Principal Purchasing Agent) 
	 PPA (Principal Purchasing Agent) 
	 PPA (Principal Purchasing Agent) 

	 MEP Status (Multiply Entity Provider) 
	 MEP Status (Multiply Entity Provider) 

	 Qualification Status 
	 Qualification Status 

	 Concerns/Issues/Comments 
	 Concerns/Issues/Comments 


	Note: The PPA field displays the agency associated to the contract in PDM.  Contracts feed over from the CIW with DMR, DSS and WEL associated with the contract, but those department names have changed.  For prequalification purposes DMR contracts need to be associated with DDS contract, DSS contracts with DCF; and WEL contracts with DTA. 
	1. Select the PPA drop down arrow and select correct agency code. 
	1. Select the PPA drop down arrow and select correct agency code. 
	1. Select the PPA drop down arrow and select correct agency code. 

	2. Select the Save button. 
	2. Select the Save button. 


	 
	Figure 43: Selecting the PPA on the Qualification page. 
	The MEP Status field can be updated. 
	3. Select the MEP Status drop down arrow and select the MEP Status. 
	3. Select the MEP Status drop down arrow and select the MEP Status. 
	3. Select the MEP Status drop down arrow and select the MEP Status. 


	MEP Status field has the following options: 
	 Contracting Child/Affiliate 
	 Contracting Child/Affiliate 
	 Contracting Child/Affiliate 

	 Contracting Parent 
	 Contracting Parent 

	 Non Contracting Child/Affiliate 
	 Non Contracting Child/Affiliate 

	 Non Contracting Parent 
	 Non Contracting Parent 

	 Single Entity 
	 Single Entity 

	4. Select the Save button. 
	4. Select the Save button. 


	 
	Figure 44: Selecting the MEP Status on the Qualification page. 
	Parent/Child/Affiliate Providers 
	The Parent/Child/Affiliate Providers section allows the POS Program Operation staff person to view and update, if needed, the other providers associated to this provider. 
	Note: Parent/Child/Affiliate Providers information will only be visible if the Provider has Child or Affiliate Providers. 
	 
	Figure 45: Parent/Child/Affiliate Providers section under the Qualification page. 
	5. Select record to view. The user will be redirected to the PDM Information page for that provider organization. 
	5. Select record to view. The user will be redirected to the PDM Information page for that provider organization. 
	5. Select record to view. The user will be redirected to the PDM Information page for that provider organization. 


	Status 
	The Status section allows the POS Program Operation staff person to update the Qualification Status.   
	6. Select the Qualification Status drop down arrow and select one of the following options: 
	6. Select the Qualification Status drop down arrow and select one of the following options: 
	6. Select the Qualification Status drop down arrow and select one of the following options: 

	 Conditional 
	 Conditional 
	 Conditional 

	 Limited 
	 Limited 

	 No POS Business 
	 No POS Business 

	 Pending 
	 Pending 

	 Provisional 
	 Provisional 

	 Public Entity 
	 Public Entity 

	 Qualification with CAP 
	 Qualification with CAP 

	 Rejected 
	 Rejected 

	 Unconditional 
	 Unconditional 


	7. Select the Save button. 
	7. Select the Save button. 


	 
	Figure 46: Status section under the Qualification page. 
	  
	Concerns/Issues  
	A user with the Principal Purchasing Agency (PPA) role can edit the Concerns/Issues section.  If a checkmark is placed in any one of the checkboxes, the user will need to add an explanation one the Corrective Measures page.  Refer to the Corrective Measures in this chapter for more information. 
	 
	Figure 47: Concerns/Issues section under the Qualification page. 
	Comments 
	A user with the Principal Purchasing Agency (PPA) role can add /delete comments in this section. 
	To Add a Comment: 
	1. Type the Comments you desire in the Comment field. 
	1. Type the Comments you desire in the Comment field. 
	1. Type the Comments you desire in the Comment field. 

	2. Select the Save button. 
	2. Select the Save button. 


	The comment will display in the comments dialog box. 
	To Delete a Comment: 
	3. Select the Delete link. 
	3. Select the Delete link. 
	3. Select the Delete link. 

	4. Select the Save button. 
	4. Select the Save button. 


	Note:  Only the author can edit and/or delete his or her own comments. 
	The graphic below represents comments added along with highlighting the Delete option. 
	 
	Figure 48: Comments section under the Qualification page. 
	 
	Note:  A reminder that if you navigate away from any page while in Edit mode without saving, PDM will prompt a Warning screen. 
	 
	 
	  
	PDM Qualification – Financial Ratios 
	The Financial Ratios tab contains vital financial ratios for current and previous two fiscal years. 
	1. Select the Financial Ratios link. 
	1. Select the Financial Ratios link. 
	1. Select the Financial Ratios link. 


	 
	Figure 49: Highlighting the Financial Ratios page from the Qualification page. 
	2. Select any of the links in the first column to open the definitions page. 
	2. Select any of the links in the first column to open the definitions page. 
	2. Select any of the links in the first column to open the definitions page. 


	 
	Figure 50: Financial Ratios page which is under Qualification. 
	3. Select Back to return to the main Qualification page or select Return to search to open the search page.  
	3. Select Back to return to the main Qualification page or select Return to search to open the search page.  
	3. Select Back to return to the main Qualification page or select Return to search to open the search page.  


	PDM Qualification – Corrective Measures 
	The Corrective Measures page is part of Provider Profile and contains Corrective measures along with comments.  
	Under the UFR Audit Findings section, if the Status field has a ‘YES’ this indicates that a checkmark was entered selected under the Qualification page for the Financial Ratios, Management Letter, Notes to Financials, or Other.  While an optional field, it is recommended that the PPA enter an explanation under UFR Audit Findings when the status is ‘YES’.  Select Edit at the bottom of the page 
	 
	Figure 51: Corrective Measures page highlighting the Concerns/Issues which requires explanation when "Yes" is displayed. 
	1. Type an explanation for each Concerns/Issues with a ‘Yes’ in the Status field. 
	1. Type an explanation for each Concerns/Issues with a ‘Yes’ in the Status field. 
	1. Type an explanation for each Concerns/Issues with a ‘Yes’ in the Status field. 

	2. Select the Save button. 
	2. Select the Save button. 


	 
	Figure 52: Completed Concerns/Issues section under Corrective Measures page. 
	The Corrective Action Plan is updated by data on the UFR and by OSD/CIW.  This is a View only section. 
	 
	Figure 53: Corrective Action Plan section under the Corrective Measures page. 
	The Audit Records (OSA AUDIT) section can be updated by the PPA. 
	1. Type the Audit Number. 
	1. Type the Audit Number. 
	1. Type the Audit Number. 

	2. Type the Issue Date. (Format: DD/MM/YYYY or  
	2. Type the Issue Date. (Format: DD/MM/YYYY or  

	3. Select the CAP Status. (Options: Open or Close) 
	3. Select the CAP Status. (Options: Open or Close) 

	4. Type the Audit Resolution Summary. 
	4. Type the Audit Resolution Summary. 

	5. Select Financial Audit Findings.  (Options: Yes or No) 
	5. Select Financial Audit Findings.  (Options: Yes or No) 

	6. Select the Add Audit Record. 
	6. Select the Add Audit Record. 


	 
	Figure 54: Audit Records (OSA Audit) section under the Corrective Measures page. 
	 
	  
	PDM CONTRACT DETAILS 
	The Contract Detail page stores information about the POS Provider’s contracts for the current fiscal year such as Activity Code, Activity Name, Doc ID, Object Code, Maximum Contract Obligation, Expended to Date, and Unexpended Amount. For Release 5.0 PDM will only display contracts with Object Codes MM3 and M03.  The POS Program Operation role allows designated staff from within the organization to view this page.  This role does not have Edit rights on this page. 
	Note: The information found under Contract Details is sourced from the Commonwealth’s Information Warehouse.  Information about services offered, but not contracted through EOHHS is entered by the provider. 
	This page provides the POS Program Operations staff with a snapshot of all of current year contracts, by EOHHS agency. 
	 
	Figure 55: Contract Detail page lists all contracts a provider has with EOHHS agencies. 
	PDM SURPLUS REVENUE 
	The Surplus Revenue page is primarily used by the Principal Purchasing Agency (PPA) to record and retain an account of the surplus revenue liability based on the Annual SSR of 5% limit. If an excess 5% Surplus Revenue Liability exists, the Principal Purchasing Agency utilizes the corresponding fields below to provide an accounting of the negotiation with the Provider to satisfy the liability owed the Commonwealth.  
	 
	Figure 56: PDM Surplus Revenue page. 
	A user assigned the POS Program Operation role can edit the following fields on the Surplus Revenue page: 
	 Date of Agency/Provider Agreement 
	 Date of Agency/Provider Agreement 
	 Date of Agency/Provider Agreement 

	 Cash Reimbursement 
	 Cash Reimbursement 

	 Free Care 
	 Free Care 

	 Adjusted Unit Rate Contract 
	 Adjusted Unit Rate Contract 

	 Other (*notes in comments) 
	 Other (*notes in comments) 

	 Costs Offset Refiled UFR 
	 Costs Offset Refiled UFR 

	 Estimated Date Reimbursement will be completed 
	 Estimated Date Reimbursement will be completed 

	 Date Reimbursement completed 
	 Date Reimbursement completed 

	 Comments 
	 Comments 


	After entering in the information, the PPA selects the Save button. 
	 
	Figure 57: PDM Surplus Revenue page in Edit mode. 
	  
	This page is intentionally left blank 
	Chapter 5: DDS Program Operations and DDS Operations Observer Roles 
	OVERVIEW 
	The DDS Program Operations and DDS Operations Observer have access to and maintain the Service Directory in PDM.  The Service Directory is a tool for consumers, their families, and circle of support to search for services and service providers in the Commonwealth of Massachusetts.  The data in the Service Directory is maintained in PDM by users assigned the DDS Program Operations role and they have the ability to add, modify and delete data in the Service Directory pending approval from appropriate source w
	DDS Program Operations: This role allows designated DDS Program staff access to the Providers associated to DDS waivers and services. These users will have access to add and manage providers, as well as waiver services. In addition they will have the capability to manage the Providers Service Directory Profile. Finally, they will have access to reports menu. 
	DDS Operations Observer: This role allows designated DDS staff to view only Provider information and predefined reports. 
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	Reminders When Using PDM: 
	 All fields denoted with an asterisk (*) are required fields and must be completed in order to save the record. 
	 All fields denoted with an asterisk (*) are required fields and must be completed in order to save the record. 
	 All fields denoted with an asterisk (*) are required fields and must be completed in order to save the record. 

	 Do not save a record until all sections are completed. If the user tries to save before completing all required fields within each section, the user will receive error messages at the top of the page listing the missing data. 
	 Do not save a record until all sections are completed. If the user tries to save before completing all required fields within each section, the user will receive error messages at the top of the page listing the missing data. 

	 If you attempt to navigate to another page while in Edit mode without saving, you will receive a warning message (different text depending on the web browser you are working in) such as: 
	 If you attempt to navigate to another page while in Edit mode without saving, you will receive a warning message (different text depending on the web browser you are working in) such as: 

	o Firefox: “This page is asking you to confirm that you want to leave – data you have entered may not be saved.” 
	o Firefox: “This page is asking you to confirm that you want to leave – data you have entered may not be saved.” 
	o Firefox: “This page is asking you to confirm that you want to leave – data you have entered may not be saved.” 

	o Internet Explorer: “Are you sure you want to navigate away from this page?  This page is asking you to confirm that you want to leave – data you have entered may not be saved.  Press OK to continue, or Cancel to stay on the current page.” 
	o Internet Explorer: “Are you sure you want to navigate away from this page?  This page is asking you to confirm that you want to leave – data you have entered may not be saved.  Press OK to continue, or Cancel to stay on the current page.” 



	For guidance on using JAWS with PDM, refer to Appendix B: JAWS Commands. 
	PROVIDER SEARCH 
	The DDS Program Operations and DDS Operations Observer both have the ability to search for providers.  In order to view provider records in PDM a search is required.  The Search page is accessed by selecting Manage Provider from the Navigation menu.  
	 
	Figure 58: Welcome to the Provider Data Management Information System page. 
	The Provider Search page allows users to search for entries in three ways: 
	1. FEIN (Federal Employee Identification Number) 
	1. FEIN (Federal Employee Identification Number) 
	1. FEIN (Federal Employee Identification Number) 

	2. Name (Provider Name) 
	2. Name (Provider Name) 

	3. Waiver Program (Specific DDS program) 
	3. Waiver Program (Specific DDS program) 


	 
	Figure 59: Provider Search page. 
	Search by FEIN: 
	1. Type in FEIN. (9-digits in length) 
	1. Type in FEIN. (9-digits in length) 
	1. Type in FEIN. (9-digits in length) 

	2. Select the Search button. 
	2. Select the Search button. 


	 
	Figure 60: Provider Search page returns with results based off of entered criteria - FEIN. 
	Search by Name: 
	1. Type in Name (Full or Partial name). 
	1. Type in Name (Full or Partial name). 
	1. Type in Name (Full or Partial name). 


	Note: Wildcard Search, the * (asterisk) can be used as a wildcard in the name field to search for a provider. If you are unsure of the full name of the provider,  or want to see all the options using a portion of a name , use the wild card to search. (i.e. *key will produce Catherine Key, Berkshire* will produce Berkshire Community Center etc., *education* will produce any provider who has the word education in their organization name.) 
	2. Select the Search button. 
	2. Select the Search button. 
	2. Select the Search button. 


	 
	Figure 61: Provider Search page returns with results based off of entered criteria - Name. 
	Search by Waiver: 
	1. Select the Waiver Program drop down menu. 
	1. Select the Waiver Program drop down menu. 
	1. Select the Waiver Program drop down menu. 


	Available Programs: 
	 ALL (Default) 
	 ALL (Default) 
	 ALL (Default) 

	 Adults Services 
	 Adults Services 

	 Autism Spectrum Services 
	 Autism Spectrum Services 

	2. Select the Search button. 
	2. Select the Search button. 


	 
	Figure 62: Provider Search page returns with results based off of entered criteria - Waiver Program. 
	SERVICE DIRECTORY 
	Once the Provider Search is executed and requested results are displayed, the user selects the Provider record by clicking in the row which redirects the user to the Service Directory page. 
	The Service Directory page lists the following information: 
	 Provider’s Details 
	 Provider’s Details 
	 Provider’s Details 

	 Other Contact Information 
	 Other Contact Information 

	 Service Information 
	 Service Information 


	Users assigned the DDS Program Operations role have Read rights access along with add/modify in the Service Directory.  The DDS Observer has Read rights only. 
	Based on assigned role, the Service Directory page will display the following buttons at the bottom of the page:  
	 DDS Program Operations: Edit and Return to Search 
	 DDS Program Operations: Edit and Return to Search 
	 DDS Program Operations: Edit and Return to Search 

	 DDS Observer: Return to Search 
	 DDS Observer: Return to Search 


	 
	Figure 63: Service Directory page with Edit button highlighted. 
	  
	UPDATE SERVICE DIRECTORY 
	A user with the DDS Program Operations role has the access rights to add/modify/delete information on the Service Directory page. 
	Provider's Details 
	Note: The Name and FEIN fields are not editable. The data comes from the Commonwealth’s Information Warehouse (CIW). 
	Under Provider’s Detail the following fields can be edited by a user with the DDS Program Operations role: 
	 Address Line 1 *, Address Line 2 
	 Address Line 1 *, Address Line 2 
	 Address Line 1 *, Address Line 2 

	 City *, State *, Zip * 
	 City *, State *, Zip * 

	 Phone and Ext * 
	 Phone and Ext * 

	 Website, Email  
	 Website, Email  


	If only updates to the Provider’s Detail section are needed,  
	 Select the Edit button. 
	 Select the Edit button. 
	 Select the Edit button. 

	 Update information as needed. 
	 Update information as needed. 

	 Select the Save button. 
	 Select the Save button. 


	Other Contact Information 
	Under Other Contact Information the following fields can be edited by a user with the DDS Program Operations role: 
	 First *, Last * 
	 First *, Last * 
	 First *, Last * 

	 Phone and Ext * 
	 Phone and Ext * 

	 Email  
	 Email  


	If only updates to the Other Contact Information section are needed,  
	 Select the Edit button. 
	 Select the Edit button. 
	 Select the Edit button. 

	 Update information as needed. 
	 Update information as needed. 

	 Select the Save button. 
	 Select the Save button. 


	 
	Figure 64: Service Directory page with Provider's Details and Other Contact Information displayed. 
	Service Information 
	The Service Information section (when in Edit mode) allows a user to add/modify/delete service information. 
	Searching for an Existing Service 
	The Select Service section in the Service Directory displays 10 records at a time on the page.  If more than 10 records exist the user should use the link First Previous 1 2 Next Last to navigate and locate the record. 
	There are two buttons under the Service Information section: 
	 Add/Modify Service: To save or modify a record in Service Directory. 
	 Add/Modify Service: To save or modify a record in Service Directory. 
	 Add/Modify Service: To save or modify a record in Service Directory. 

	 Delete Service: To delete a record in Service Directory. 
	 Delete Service: To delete a record in Service Directory. 


	 
	Figure 65: Service Directory page displayed with highlight around First Previous Next Last navigation links and the Add/Modify Service and Delete buttons. 
	  
	ADD SERVICE 
	When a new service needs to be added a user with the DDS Program Operations role can add the service to the Service Directory. 
	1. Search and select Provider from the Provider Search page. 
	1. Search and select Provider from the Provider Search page. 
	1. Search and select Provider from the Provider Search page. 

	2. Select the Edit button from the Service Directory page. 
	2. Select the Edit button from the Service Directory page. 

	3. Select the Program Type * from the drop down menu. 
	3. Select the Program Type * from the drop down menu. 

	4. Select the Service Type * from the drop down menu. 
	4. Select the Service Type * from the drop down menu. 

	5. Type in the Start Date * (Format: MM/DD/YYYY or select the Calendar icon to select the date) 
	5. Type in the Start Date * (Format: MM/DD/YYYY or select the Calendar icon to select the date) 

	6. Select the City * (To select multiple cities use Shift + click). 
	6. Select the City * (To select multiple cities use Shift + click). 

	7. Select the Language * (To select multiple languages use Shift + click). 
	7. Select the Language * (To select multiple languages use Shift + click). 

	8. Select the Add/Modify Service button. 
	8. Select the Add/Modify Service button. 


	 
	Figure 66: Service Directory page displayed with highlight around Add/Modify Service button. 
	PDM will return the validation message “Service added successfully.” 
	MODIFY SERVICE 
	If a service needs to be modified due to a change in the Start Date or when an additional City or Language needs to be added a user with the DDS Program Operations role can modify an existing service on the Service Directory. 
	1. Search and select Provider from the Provider Search page. 
	1. Search and select Provider from the Provider Search page. 
	1. Search and select Provider from the Provider Search page. 

	2. Select the Edit button. 
	2. Select the Edit button. 

	3. Locate and select service to be modified from the Select Service section. 
	3. Locate and select service to be modified from the Select Service section. 


	Note: The Program Type and Service Type fields are not editable when modifying a service. 
	4. Update the Start Date * field, if needed (Format: MM/DD/YYYY or select the Calendar icon to select the date) 
	4. Update the Start Date * field, if needed (Format: MM/DD/YYYY or select the Calendar icon to select the date) 
	4. Update the Start Date * field, if needed (Format: MM/DD/YYYY or select the Calendar icon to select the date) 

	5. Update the City * field, if needed (To select multiple cities use Shift + click). 
	5. Update the City * field, if needed (To select multiple cities use Shift + click). 

	6. Update the Language * field, if needed (To select multiple languages use Shift + click). 
	6. Update the Language * field, if needed (To select multiple languages use Shift + click). 


	7. Select the Add/Modify Service button. 
	7. Select the Add/Modify Service button. 
	7. Select the Add/Modify Service button. 


	 
	Figure 67: Service Directory page displayed with highlights around Add/Modify Service fields. 
	PDM will return the validation message “Service modified successfully.” 
	DELETE SERVICE 
	If a service needs to be deleted a user with the DDS Program Operations role has the access to delete a service from the Service Directory. 
	1. Search and select the provider from Provide Search page. 
	1. Search and select the provider from Provide Search page. 
	1. Search and select the provider from Provide Search page. 

	2. Under Service Information, locate and select the service to be deleted from the Select Service listing. 
	2. Under Service Information, locate and select the service to be deleted from the Select Service listing. 

	3. Select the Delete Service button.  
	3. Select the Delete Service button.  


	 
	Figure 68: Service Directory page displayed with highlights around the Delete Service fields. 
	PDM will return the validation message: “Service deleted successfully.”  
	Note: All fields denoted with an asterisk (*) are required fields and must be completed in order to save the record. 
	  
	Chapter 6: PDM Contracted Providers Operations and Observer Provider Roles 
	OVERVIEW 
	The PDM Contracted Providers Operations and PDM Observer Provider roles allow designated staff from within their organization to view and edit information in PDM. 
	PDM Contracted Providers Operations: This role allows providers access to their PDM record only. Providers with this access have the capability to edit and update company profile information. Access will include the ability to upload and replace required documents. This role will also have access to provider specific reports. (May have access to Salary Reserve functionality - to follow in later release). 
	PDM Observer Provider: This role allows providers access to VIEW only the provider's PDM company profile information. This role will have access to designated reports specific to the provider's company business with EOHHS. 
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	Reminders When Using PDM: 
	 All fields denoted with an asterisk (*) are required fields and must be completed in order to save the record. 
	 All fields denoted with an asterisk (*) are required fields and must be completed in order to save the record. 
	 All fields denoted with an asterisk (*) are required fields and must be completed in order to save the record. 

	 Do not save a record until all sections are completed. If the user tries to save before completing all required fields within each section, the user will receive error messages at the top of the page listing the missing data. 
	 Do not save a record until all sections are completed. If the user tries to save before completing all required fields within each section, the user will receive error messages at the top of the page listing the missing data. 

	 If you attempt to navigate to another page while in Edit mode without first saving you will receive a warning message (different text depending on the web browser you are working in) such as: 
	 If you attempt to navigate to another page while in Edit mode without first saving you will receive a warning message (different text depending on the web browser you are working in) such as: 

	 Firefox: “This page is asking you to confirm that you want to leave – data you have entered may not be saved.” 
	 Firefox: “This page is asking you to confirm that you want to leave – data you have entered may not be saved.” 

	 Internet Explorer: “Are you sure you want to navigate away from this page?  This page is asking you to confirm that you want to leave – data you have entered may not be saved.  Press OK to continue, or Cancel to stay on the current page.” 
	 Internet Explorer: “Are you sure you want to navigate away from this page?  This page is asking you to confirm that you want to leave – data you have entered may not be saved.  Press OK to continue, or Cancel to stay on the current page.” 


	For guidance on using JAWS with PDM, refer to Appendix B: JAWS Commands. 
	PDM INFORMATION 
	The Information tab stores information about a Provider such as Corporate Contact Information, Provider’s PDM Contact, Executive Contact, and General Corporate Information (Mission Statement and Corporate Description).   
	When a provider selects the ‘Manage Provider’ from the Welcome page they are automatically redirected to the Provider page (no search is required) and defaults to the Information page. 
	Users assigned the PDM Contracted Providers Operations role have Edit and Read rights on the Information page.  The PDM Observer Provider has View rights only. 
	The Information page has the following button located at the bottom of the page: 
	 Edit: The Edit button will appear for users with the PDM Contracted Providers Operations role. 
	 Edit: The Edit button will appear for users with the PDM Contracted Providers Operations role. 
	 Edit: The Edit button will appear for users with the PDM Contracted Providers Operations role. 

	 No button will display for users with the PDM Observer Provider role. 
	 No button will display for users with the PDM Observer Provider role. 


	 
	Figure 69: PDM Information page with Edit button highlighted. 
	Corporate Contact Information  
	Under Corporate Contact Information the following fields can be edited by a user with the PDM Contracted Providers Operations role: 
	 Alternate Address 
	 Alternate Address 
	 Alternate Address 

	 Phone, Fax 
	 Phone, Fax 

	 Email, Website 
	 Email, Website 


	Note: The Provider Name, FEIN and Legal Address fields are not editable. This data comes from the Commonwealth’s Information Warehouse (CIW). 
	 
	Figure 70: Fields that can be updated on Information > Corporate Contact Information section of the Information page. 
	If only updates to the Corporate Contact Information section are needed, select the Save button at the bottom of the page. 
	Provider’s PDM Contact 
	Under Provider’s PDM Contact the following fields can be edited by a user with the PDM Contracted Providers Operations role: 
	 First, Middle, and Last  
	 First, Middle, and Last  
	 First, Middle, and Last  

	 Phone, Email, Fax 
	 Phone, Email, Fax 


	 
	Figure 71: Fields that can be updated on Information > Provider's PDM Contact section of the Information page. 
	If only updates to the Provider’s PDM Contact section are needed, select the Save button at the bottom of page. 
	  
	Executive Contacts 
	Under Executive Contacts > CEO/Executive Director the following fields can be edited by a user with the PDM Contracted Providers Operations role: 
	 First, Middle, and Last  
	 First, Middle, and Last  
	 First, Middle, and Last  

	 Phone, Email 
	 Phone, Email 


	Under Executive Contacts > Chief Financial Officer the following fields can be edited by a user with the PDM Contracted Providers Operations role: 
	 First, Middle, and Last  
	 First, Middle, and Last  
	 First, Middle, and Last  

	 Phone, Email 
	 Phone, Email 


	If only updates to the Executive Contacts section are needed, select the Save button at the bottom of page. 
	 
	Figure 72: Fields that can be updated on Information > Executive Contacts section of the Information page. 
	General Corporate Information 
	Under General Corporate Information the following field can be edited by a user with the PDM Contracted Providers Operations role: 
	 Mission Statement 
	 Mission Statement 
	 Mission Statement 

	 Corporate Description 
	 Corporate Description 


	If only updates to the General Corporate Information section are needed, select the Save button at the bottom of page. 
	 
	Figure 73: Fields that can be updated on Information > General Corporate Information section on the Information page. 
	SERVICE DIRECTORY 
	Note: Only provider organizations that have contracts with DDS will see the Service Directory link under the Information page.   
	Once the Provider Search is executed and requested results are displayed, the user selects the Provider record by clicking in the row to display the Corporate Information page. To the right of the information page is the Service Directory link. 
	1. Select the Service Directory link. 
	1. Select the Service Directory link. 
	1. Select the Service Directory link. 


	 
	Figure 74: Service Directory link on the Information page. 
	The Service Directory page lists the following information: 
	 Provider’s Details 
	 Provider’s Details 
	 Provider’s Details 

	 Other Contact Information 
	 Other Contact Information 

	 Service Information 
	 Service Information 


	The Provider Organization with DDS contracts has Read rights only to this information. 
	 
	Figure 75: Service Directory page (view only). 
	Searching for an Existing Service 
	The Select Service section in the Service Directory displays 10 records at a time on the page.  If more than 10 records exist the user should use the link First Previous 1 2 Next Last to navigate and locate the record. 
	 
	Figure 76: Service Directory page displayed with highlight around First Previous Next Last navigation links. 
	  
	PDM QUALIFICATION 
	The PDM Qualification page is populated when the EOHHS Principal Purchasing Agency (PPA) Provider Qualification Officer (PQO) completes the review process.   The PDM system calculates the financial ratios field using data from Provider’s UFR filing from OSD data feed and cannot be edited.  
	Users assigned the PDM Contracted Providers Operations role and PDM Observer Provider have View rights only to the Qualification page and associated links. 
	 
	Figure 77: PDM Qualification page. 
	Qualification – Viewing PQ Year 
	PDM maintains the current PQ year along with previous years.  The Qualifications page defaults to the current PQ Year.   
	To view a prior PQ Year,  
	1. Select the PQ Year drop down arrow and select the Year to be viewed. (This example will select 2011). 
	1. Select the PQ Year drop down arrow and select the Year to be viewed. (This example will select 2011). 
	1. Select the PQ Year drop down arrow and select the Year to be viewed. (This example will select 2011). 

	2. Select the Update button. 
	2. Select the Update button. 


	 
	Figure 78: Under the Qualifications page, changing the PQ Year to 2011 and selecting the Update button. 
	Note: Each time the PQ Year is selected it must be followed by selecting the update button to ensure all data is up to date per the selection. 
	Parent/Child/Affiliate Providers 
	The Parent/Child/Affiliate Providers section allows the user to view the other provider organizations associated to this provider. 
	Note: Parent/Child/Affiliate Providers information will only be visible if the Provider has Child or Affiliate Providers. 
	 
	Figure 79: Parent/Child/Affiliate Providers section under the Qualification page. 
	3. Select record to view. The user will be redirected to the PDM Information page for that provider organization. 
	3. Select record to view. The user will be redirected to the PDM Information page for that provider organization. 
	3. Select record to view. The user will be redirected to the PDM Information page for that provider organization. 


	  
	PDM Qualification - Financial Ratios 
	The Financial Ratios page assists agencies in assessing the financial stability of a provider.  The EOHHS Purchase of Service (POS) Integrity Unit established the standard Financial Assessment Measures and benchmarks. The Financial Ratios page is pre-populated when the Operational Services Division (OSD) receives a provider’s annual Uniform Financial Report (UFR) and parses the information into the OSD database.   
	The PDM Contracted Providers Operations and PDM Observer Provider roles allow designated staff from within the organization to view this page.  This page is View only for all associated roles. 
	1. Select the Financial Ratios link 
	1. Select the Financial Ratios link 
	1. Select the Financial Ratios link 


	 
	Figure 80: Highlighting the Financial Ratios link on the Qualification page. 
	The Financial Ratio page displays the last 3 fiscal years prior to the PQ year selected. 
	2. Select any one of the links in the first column to open the Financial Ratios Definitions page. 
	2. Select any one of the links in the first column to open the Financial Ratios Definitions page. 
	2. Select any one of the links in the first column to open the Financial Ratios Definitions page. 


	 
	Figure 81: Financial Ratios page which is located under the Qualification page. 
	3. Select Back to return to the Financial Ratio page. 
	3. Select Back to return to the Financial Ratio page. 
	3. Select Back to return to the Financial Ratio page. 


	  
	PDM Qualification - Corrective Measures 
	The Corrective Measures page displays, by PQ Fiscal Year, the UFR Audit Findings, the Corrective Action Plan, and Audit Records (OSA Audit).   
	The PDM Contracted Providers Operations and PDM Observer Provider roles allow designated staff from within the organization to view this page.  This page is View only for all associated roles. 
	 
	Figure 82: Corrective Measures page. 
	Qualification – Viewing PQ Year 
	PDM maintains the current PQ year along with previous years.  The Qualifications page defaults to the current PQ Year.   
	To view a prior PQ Year,  
	1. Select the PQ Year drop down arrow and select the Year to be viewed.  
	1. Select the PQ Year drop down arrow and select the Year to be viewed.  
	1. Select the PQ Year drop down arrow and select the Year to be viewed.  

	2. Select the Update button. 
	2. Select the Update button. 


	 
	Figure 83: Corrective Measures page with the PQ Year highlighted. 
	Note: Each time the PQ Year is selected it must be followed by selecting the update button to ensure all data is up to date per the selection. 
	  
	PDM CONTRACT DETAILS 
	The Contract Detail page stores information about the POS Provider’s contracts for the current fiscal year such as Activity Code, Activity Name, Doc ID, Object Code, Maximum Contract Obligation, Expended to Date, and Unexpended Amount.  For Release 5.0 PDM will only display contracts with Object Codes MM3 and M03. 
	The PDM Contracted Providers Operations and PDM Observer Provider roles allow designated staff from within the organization to view this page.  These roles do not have Edit rights on this page. 
	Note: The information found under Contract Details is sourced from the Commonwealth’s Information Warehouse.  Information about services offered, but not contracted through EOHHS is entered by the provider. 
	This page provides the Provider with a snapshot of all of current year contracts, by EOHHS agency.  
	 
	Figure 84: Contract Detail page lists all contracts a provider has with EOHHS agencies. 
	PDM SURPLUS REVENUE 
	The Surplus Revenue page is primarily used by the Principal Purchasing Agency (PPA) to record and retain an account of the surplus revenue liability based on the Annual SSR of 5% limit. If an excess 5% Surplus Revenue Liability exists, the Principal Purchasing Agency utilizes the corresponding fields below to provide an accounting of the negotiation with the Provider to satisfy the liability owed the Commonwealth.  
	 
	Figure 85: PDM Surplus Revenue page. 
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